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Document Version History 
Date Version Changes 

05/04/2020 3.0 Updated Software Version to 5.22.3.0. 

Updated copyright information. 

Reformatted. 

Applied navigation and hyperlinking throughout. 

Updated Recommended PC or Server Requirements. 

Updated Minimum PC Requirements. 

Updated Communication Options. This change is because 
an old mainboard has a “card” and the new mainboard has 
an on-board connection. 

Under Select System Type added the ability to “enter a 
UNC path to the Shared folder”. 

Replaced screenshot to show that Redial checkbox option 
has been renamed to Reconnect on Failure on the 
Configuration > Hardware Tab. 

Replaced screenshot to show that Encoder Port options 
have been removed from the Configuration > Encoder tab. 

Replaced screenshot to show options for AIM Firmware 
images to be selected for upload on Configuration > 
Firmware tab. 
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Replaced screenshot to show addition of Retrieve OBD 
Logs during online session checkbox on the Configuration 
> AIM tab. 

Replaced screenshot to show updated view of Pre-
Programmed Products List. 

Replaced screenshots to show updated view of 
Creating/Editing a Product. 

Replaced screenshots to show updated view of Site 
information and Connection type. 

Replaced Appendix D – Dash Odometer for Light Duty 
CAN Vehicles with Appendix D  Dash Odometer for 
AIM2.4®  & AIM Titanium™. 

Added Appendix F – Managing FMU Settings.  

Added Appendix G - MPDS Online Client Permissions 

Replaced screenshots to show updated view of Phone 
Connection. 

Replaced screenshots to show MAC Address is not 
supported at this time on the LAN Connection Config 
Dialog. 

Replaced screenshot to show updated view of Vehicle 
Record > General tab. 

Updated screenshots throughout to match current OS. 

Updated glossary listing for Transaction Code, switching 
“digit” to “character” as alphanumeric characters are 
allowed. 

Added a note to AIM Programming that AIM Programmer 
Keys may only be used at the FMU with the Plus with AIM 
Prog FMU type. The regular Plus with AIM type is not 
authorized for AIM programming.  

Added a note to Vehicle and User Prokee Option Defaults 
for Global Configuration that transactions will be copied to 
ExportTrans. this takes up disk space, so enable it only if 
you intend to export. 
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• Minimum PC Requirements 
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Added AIM Bulk Installation section . 

Updated Database Manager section to include updated Browse 
button functionality. 

Updated Archive Records section 

Added Restore Records section 

Added System Diagnostics section 

12/5/2022 5.0 Updated Minimum PC Requirements 

Updated Notes throughout 
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Related documentation 
The following Syntech documentation contains information to which you may need to 
refer: 

• FuelMaster Installation Guide SW 5.23.3.0 

• Site Operations Manual 

• AIM Installation and Site Operations Manuals 

Conventions used in this guide  
A Glossary of terms and acronyms are also included. 

To help you find important information, this guide uses the following conventions: 
 

This convention Indicates 

Bold text The names of elements of the user interface, such as menus, 
buttons, and options 

Italic text Code, file name, directory paths, and on-screen computer 
output. 

NOTE Notes that contain additional explanation. 

 Information related to when you should call the Syntech 
Customer Satisfaction Center (CSC). 

About the User Manual 
This manual provides information and instructions for the FMPlus application that is 
used to create, configure, and view system generated data.  

Audience 
The FMPlus User Manual is directed at those personnel that are granted system access 
for the purpose of performing system functions. 
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Certifications 

Certifications have been awarded by the following organizations.  

 US and Canadian equipment certifications through the following:  

o FCC (Federal Communications Commission),  

o Intertek (ETL, cETL),  

o CAN/CSA (Canadian Standards Association),  

o National Conference on Weights and Measures (National Type Evaluation 
Program: NTEP),  

o Payment Card Industry (PCI) Security Standards Council (PA-DSS 
compliance),  

 European equipment certification through the following:  

o TUV SUD, FM Approvals  

o ATEC Certification 

 Microsoft Gold Partner 

Recommended PC or Server Requirements 
 Intel Core i3 Processor or greater 

 4GB of RAM  

 DVD-ROM  

 12GB free Hard Drive space – Additional space required if running full MS SQL 
Server for large databases. 

 56K Baud Analog Modem  

 1024x768 Screen Resolution  

 Network Connection  

 USB for Key Encoding, if needed  

 Solid State Drive (SSD) 

Supported OSes 
 Windows 10 64-bit 

 Windows Server 2008/R2 64-bit 

 Windows Server 2016 64-bit 

Microsoft versions above these listed will also be supported. 
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Minimum PC Requirements 
 3.0 GHz Pentium 4 Processor 64-bit 

 2GB of RAM for 64-bit 

 12x CD-ROM  

 6 GB free Hard Drive space  

 33.6K Baud Analog Modem or Network Internet Connection 

 1024x768 Screen Resolution  

 USB for Key Encoding, if needed  

 Windows 10 64-bit 
 

NOTE FMPlus is not compatible with Microsoft HOME editions or Windows 10 
or 11 running in S-mode.. 
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Chapter 1 Introduction 

About FuelMaster Plus (FMPlus) 
FMPlus is a fuel management system comprised of a software application and 
subsystems, which cooperate for data entry, collection, display, and reporting of 
system generated fueling/inventory transactions and vehicle telematics. 

FMPlus software collects data produced by the following: 

 Fuel Management Units (FMUs) 
 Remote Data Collection Units (RDCUs) 
 Automotive Information Modules (AIMs)  
 Tank Monitoring Units (TMUs) 

System generated data is captured and stored in the software, providing users with 
system status, a view of fuel inventories, transactions and vehicle telematics. 

System Components 

Central Controller 

The term Central Controller denotes two things in this manual.  First, the Central 
Controller can refer to an individual who manages FMPlus and equipment.  Second, 
the term can be used for any computer that executes FMPlus. 

FMU 

The Fuel Management Unit (FMU) is the FuelMaster system that controls fueling at 
the fuel island dispenser(s).  The FMU controls access to the fuel records. This data is 
then downloaded by the Central Controller software where it is used for accounting 
or fleet management purposes. 

TMU 

A Tank Monitor Unit (TMU) is used to record the status of fuel tanks. The FMU can 
interact with the TMU for generating Tank Reports; the FMU can only read 
information from the TMU. TMUs are third party devices that FuelMaster can interact 
with for report generation only. Examples are Veeder-Root, Pneumercator, Ronan, 
and Red Jacket. 
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Access Devices 

FuelMaster has several types of devices that allow the user to gain access to the fuel 
via the FMU. 

Prokee 

The Prokee is a proprietary, electronic, programmable chip embedded in a hard-
plastic casing. 

Smart Card 

The Smart Card is the size of a credit card with a smart chip embedded on the back.  
It works essentially the same as a Prokee but uses different readers on the FMU and 
Central Controller. 

AIM 

The Automotive Information Module (AIM) is used to authorize fueling without 
requiring user interaction with the FMU (passive fueling) and interfaces with the OBD 
II port on the vehicle accessing readable information from the vehicle’s computer. 
This allows information to be recorded by the FMU from the vehicle such as vehicle 
ID, odometer, current mileage, date, time, fuel quantity, fuel type, engine hours, PTO 
hours and much more. 

Credit Card 

Retail customers can provide credit card processing capability at the FMU.  Multiple 
credit card networks are supported; for a full list of credit card networks and to 
determine which best fits your needs, contact your sales representative directly or 
sales/marketing through corporate headquarters at (800) 888-9136. 

Proximity Card 

HID Thinline II Proximity Reader can be interfaced with the FMU. Wiegand format 
Proximity Cards cannot be purchased from FuelMaster but can interface with the 
system to acknowledge input as a User ID. The proximity card is only compatible 
with VMN and Keyless Systems. 
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Communication Options 
There are two methods of communication to use for daily operations; analog modem 
and network card or on-board LAN. 

Analog Modem 

The analog phone method requires a dedicated analog phone line wired to the FMU 
and a modem for the Central Controller. Serial USRobotics® external modems, or 
MultiTech® external modems, are recommended for use with FuelMaster Systems.  
There are a variety of ways to implement this feature including wireless phone line 
extenders and phone line simulators.  

Network Connection 

The network option uses existing network infrastructure for communication between 
the Central Controller and FMU.  This option requires that CAT-5 cable be run to the 
FMU no longer than 150 ft. from the nearest switch/router for best connectivity. The 
Central Controller also needs to be on the same network infrastructure. 

System Types 

Verified Miscellaneous Number (VMN) 

VMN systems have a Prokee or Smart Card encoded with a Vehicle ID to access 
fueling and require verified User ID keypad entry prior to authorization. 

Verified Vehicle ID (VVI) 

VVI systems encode the User ID on the Prokee or Smart Card and require a verified 
Vehicle ID keypad entry prior to authorization. 

Commercial Vehicle Key Only (VKO) 

VKO systems require an encoded Vehicle Key followed by User ID keypad entry. The 
difference between this and VMN is that the User ID is not verified and can be 
alphanumeric. 

Commercial User Key Only (UKO) 

UKO systems require an encoded User Key followed by Vehicle ID keypad entry. The 
difference between this and VVI is that the Vehicle ID is not verified and can be 
alphanumeric. 
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Commercial Either Key (EK) 

EK system allows for the encoding and use of either Vehicle or User keys depending 
on fueler needs. The system prompts for a User ID if a Vehicle key is inserted and a 
Vehicle ID if a User key is inserted. Neither IDs entered at the keypad are verified and 
can therefore be alphanumeric. 

Commercial Both Key (2K) 

2K systems behave like the VMN/VVI systems with one exception; the fueler is not 
prompted for a User or Vehicle ID and must use a second key before authorization 
will take place. The fueler uses this system by inserting their Vehicle key and then 
inserting a User key, or vice versa. Both are required for authorization. 

Keyless (Keyless) 

Keyless does not require keys and supports alphanumeric values for IDs. The Vehicle 
and User IDs are prompted and entered on the keypad. The Keyless system can be 
setup multiple ways and needs to be configured by a Syntech Field Service 
Representative, Syntech CSC Technician, or a Syntech Authorized Service 
Representative. 

Over the Road (OTR) 

OTR systems allow for the recording of fuel for refrigerated trailers. OTR is based on 
the VMN system but has the option for a reefer identifier to be recorded while only 
using one Vehicle key. The fueler enters the key, is prompted to enter a User ID, then 
prompted “ARE YOU FUELING A REEFER” (Y/N). If the user enters 'Yes', they are 
prompted for the Reefer ID. The transaction is recorded for the trailer, not the 
Vehicle, and the reefer ID is verified. If the user enters ‘No’, the Vehicle transaction 
progresses normally. The Reefer IDs are created and stored in the Vehicle List. 
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Chapter 2 Getting Started 

Initial Startup 
Before starting up FMPlus, determine your System Type; see Systems Types in Chapter 
1. To begin the software launch, double click the FMPlus icon located on the desktop. 

 

If no database exists, click on Create New Database. The database screen will open. 

 

A MS SQL database can be created with SQL Auth (recommended) or Windows Auth. 
Click on Create Database. 

 

See Creating a New or Using an Existing SQL Database for FuelMaster in the 
FuelMaster Installation Guide for further instructions. 
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At the end of the database creation, the logon screen launches with the default Admin 
user. Click OK. The software prompts the user to set a password for the Admin 
account.  

 

Logging into FMPlus for the first time 
When logging into the application for the first time and/or after a password 
reset/expiration, create a new password; click OK. When the password change screen 
appears, enter and confirm the new password; click OK. 

NOTE Remember the password as it will be needed each time for logging into 
FMPlus. 

  

Creating a Password 

 Password requirements and restrictions are defined in  Security Configuration. 
See Chapter 13. 

 The following special characters are not allowed in passwords: <  >  ‘  :  ; 
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Select System Type 

Select the System Type. See System Types in Chapter 1. 

 

The Category option allows aviation sites to have Vehicle verbiage replaced with 
Aircraft verbiage. 

After completing the System Type, choose a Passive System Type, if applicable. The 
Passive System types are NONE or AIM. If AIMs are not being used, select NONE; click 
OK. 

 

 

NOTE You may change the Passive System Type option later from the System > 
Configuration > System tab. 

Next, enter the Site Signature, a key that uniquely identifies and distinguishes one 
FuelMaster customer from another. The Site Signature Key is a twelve-digit string that 
can be found on the packing slip. 

Enter the key into the field, including hyphens or dashes; click OK. 
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Select a folder for saving downloads and log files. Any users running the Central 
Controller and the user Download Service “runs as” must have access to the location 
selected. Browse to a network location, and select a Shared folder, or enter a UNC 
path to the Shared folder. Click OK. 

 

The last screen before the software window is the Download Service. If the Central 
Controller will run an FM Download Service, select Yes. 

 

Report Configuration 
The Crystal Reports in FMPlus require ODBC connectivity to SQL Server. To run 
the Crystal Reports provided with FMPlus, an ODBC Data Source Name (DSN) 
configured to connect to the FMPlus database must be created on each 
machine running FMPlus. The DSN must also be set correctly for each 
corresponding entry in FMPlus > System > Database Manager. See ODBC 
Connections for Reports. 

Encoder Driver Installation 
Prokees and Smart Cards require the encoder drivers be installed on the 
Central Controller machines. The drivers are included in \\Program Files 
(x86)\Syntech\FuelMaster\USB Encoder Install Disk.  
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Insert the USB connector from the ARM7 USB Prokee Encoder into a USB port 
on the Central Controller. Open Device Manager and locate SYNTECH EN-PR 
200. 

 

Double-click to open the device Properties. Select update drivers; then select 
Browse my computer for driver software. Browse to the FuelMaster directory 
and highlight USB Encoder Install Disk.  
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With Include subfolders checked, click Next.  

 

Click Install to trust software from Syntech Systems, Inc. When the drivers are 
successfully installed, they appear in Device Manager under Universal Serial 
Bus Controllers.  
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Chapter 3 System Configuration 

FuelMaster is designed to meet a large range of end user requirements and 
configuration possibilities. These options are all based upon a foundation of options 
and configuration settings that need to be established before proceeding. Some of the 
options can be easily changed later; others will require you to contact the Syntech 
Systems, Inc.’s CSC for further assistance. 

System Configuration 
Access the System Configuration option by selecting Config on the toolbar.  This 
option can also be found under System > Configuration or by the hot key combination 
CTRL + G. 

 

Info Tab 

The first tab of the Configuration window is the Central Controller information.  Enter 
information about your company. This information is included in reports and invoices 
and appears as contact information.  
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System Tab 

The System tab is used to configure various system options.  

 

Misc Fields 1-5  

The miscellaneous fields are used to provide extra levels of reporting for Prokee/Smart 
Card or AIM fueling (e.g., to track the vehicles that fuel by VIN#, set miscellaneous 1 
field as VIN# and enter each individual VIN# in the Vehicle Record; you may then run 
reports based on those VIN#’s). 

System Key Information & System Type 

The System Key Information and System Type display the options selected when you 
first setup FMPlus. To read about system types, see System Types in Chapter 1.  The 
example in Chapter 3 shows a Keyless system where the System Key Information is 
Vehicle Key. This setting controls whether Vehicle Option Defaults or User Option 
Defaults are active.   

Vehicle and User Prokee Option Defaults for Global Configuration 

Options checked here will prepopulate the vehicle or user record options when adding 
new ones. 

 Odometer requires an odometer reading keypad entry upon fueling.  

 PIN (Prokee Internal Number) option requires PIN keypad entry upon fueling. 
The Prokee Internal Number cannot be modified; this number is hard coded on 
each key.   

 Receipt prompts the user/customer if they would like a receipt at the FMU.   

 Vehicle/User ID requires a Vehicle/User ID keypad entry before fueling; this 
option may be modified depending on the System Type. 
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7 Digit Odometer 

Requires user/customer to enter 7-digit odometers at the FMU. This option is not 
reversible, so choose with care. 

Passive System Type 

If you are using AIM units for fueling, select AIM in the dropdown list.  If not, select 
NONE.  

Patch List Timeout  

Configures the amount of time the software waits for the FMU to apply a patch or list.  
Time is entered in seconds and defaults to 90.  If the customer has small lists, 
downloads can be sped up potentially with a smaller value. For large lists, the timeout 
can be increased to give the FMU enough time to finish (should only be done with a 
CSC tech helping). 

Added Comm Timeout  

Configures the amount of time the software adds for SW and FMU communications. 
This feature supports Satellite Cellular Modems, most often used with Passive Mobile 
Units, but impacts all communication timeouts. See Communication Timeout. 

Allow transaction export 

Determines whether the system allows transaction exports. 

NOTE Transactions will be copied to ExportTrans. this takes up disk space, so enable 
it only if you intend to export. 

Require Customer ID 

Prompts users/customers for their Customer ID. It also ties Customer ID to the 
Vehicle/User records. 

Allow TMU Deliveries 

If checked and the FMU is connected to your TMU, the FMU updates the inventory 
maintained by FMPlus when a delivery is made or stick reading reveals inventory is 
required. 

Allow TMU Quantities 

If checked and the FMU is connected to your TMU, the FMU adds TMU quantities to 
the inventory maintained by FMPlus. 

Retry Transaction Files 

When enabled, the Central Controller can retry downloading transaction files from the 
FMU multiple times in the same online session.   
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Hardware Tab 

To access the hardware configuration options for your modem, select the Hardware 
tab from the configuration interface.  If your system uses a Network option for 
communicating with the FMU, please skip to Reconnect on Failure option. These 
settings are global for all sites created in your software. To restrict baud rate per site, 
call the Syntech Systems, Inc.’s CSC at 1-800-888-9136 ext. 2. 

 

Modem Options 

Syntech recommends US Robotics® external full duplex modems for all FuelMaster 
systems.  

The FM Download Service reads the configuration settings before every connection, 
not just at startup. When the modem field is populated, the SW dynamically finds the 
COM port before each connection. When Override Comm. Port is checked, the modem 
field is blanked and greyed out and FMPlus exclusively uses the Comm Port as set.  

Set up Modem 

1. Select your modem from the dropdown unless using the Override. 

2. Ensure CSC sets the Baud Rate; they will typically start at 19200 and change to 
a lower baud rate if connection problems occur. 

3. Unless directed by the Syntech Systems, Inc.’s CSC, leave the Additional Setup 
String blank, and the Use My Own Initialization String check box to the right 
unchecked. 

4. Set the Dial Timeout to the appropriate length (it will need to be longer if 
dialing through a switch or accessing an outside line.) 
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5. Set the Default Modem Timeout to the appropriate length. 

Wait for Tone Option 

Select whether you want the modem to wait on tone to dial. The most common setting 
is Yes. 

Dial Method Options 

If your phone system is pulse, select Pulse.  Otherwise leave it as Tone. 

Reconnect on Failure Options 

Set the number of times you want the system to redial and the amount of time to wait 
between each attempt. 

Encoder Tab 

Select Prokee or Smart Cards in Encoder Type. 

If the encoder drivers have not been installed, see Chapter 2 Getting Started. 
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DL Service Tab  

The FM Download Services have several configuration options. This tab also allows the 
Download path to be reset and defines the location to save the Data Logger files.  

NOTE Stop the Download Service before changing the Download Path. Download 
Path Options may also be reset from the System > Reset Download Path 
menu. 

 

Always start FM Download Service when loading FuelMaster 

If not running, start the FM Download Service when launching FMPlus. 

Display autodownloaded polling report on this computer 

Check this option to display the Polling Report on this Central Controller for Auto 
Downloads.  

Force starting Download Service as a normal.exe 

If selected, this option runs the FM Download Service as an executable. In most 
circumstances, it should run as a service. Only select this option if advised to do so by 
Syntech Systems, Inc.’s CSC. 

Start .exe now / Stop .exe now 

These buttons are only enabled when the FM Download Service is running as an 
executable. Click to start or stop the Download Service. 

Download Path Options 

When resetting the Download Path, the FM Download Service must be stopped. 
Browse to select the new location. Restart the FM Download Service when set. 
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Data Logger Options 

Browse to specify the location to save Data Logger files. 

Firmware Tab 

In support of automated FMU upgrades, the Firmware version can be selected and set 
on the Firmware tab.  

Once set, the FMU FW image name displays by the Choose Image button. Having the 
image on the FMU when the automatic upgrade begins decreases the total upgrade 
time. Contact Syntech Systems, Inc.’s CSC for more information or to request an 
automatic upgrade. 

AIM Firmware images may also be selected for upload. 

 

Enter the number of sites to update in each online session for FMU FW and AIM FW as 
applicable.  
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AIM Tab 

AIM Option Defaults are set in FMPlus and sent via the AIM Programming List to 
update the AIMs. Select the options desired. See Appendix C – SW Configuration for 
AIM Options. 

 
Mandatory AIM Completed List Download 

Downloads the AIM Completed List for every online session. This option should always 
be selected. 

Retrieve AIM Vehicle Interface Info Log during online session 

Downloads the AIM Vehicle Interface Info Log for every online session even when 
Download OBD Data Logs is not selected in the Online Client. 

Retrieve OBD Logs during online session 

Downloads the OBD logs for every online session. Uncheck if OBD logs are not desired. 
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Chapter 4 Products and Pricing 

Products and pricing are central to the function of the FuelMaster system.  
Prokees/Smart Cards are only allowed to get products they are authorized to 
dispense. This configuration is especially critical for credit card systems since pricing 
is finalized when the transaction completes. 

Products  
To access the Products List, select the Products option from the Tables menu. 

Use this feature to setup products and modify pricing as needed. This is also where 
pricing adjustments are applied.  

NOTE All prices must be uploaded to the FMU before they will have any effect on 
transaction pricing. 
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Pre-Programmed Products 

The FMPlus database comes preprogrammed with three products: Unleaded, Diesel, 
and OilCheck.   

 

  

If you have these products, double click on the product, or highlight a product and 
click Open, to modify as desired.  If not, you may highlight the product and click the 
Delete button to remove it from the Products List.  

NOTE Product 63, OilCheck, is used with FMU oil check transactions and, as such, 
should not be deleted. 

Creating/Editing a Product 
To create a new product, click the Add button from the Product List. This displays 
the product configuration interface. To edit, double click the Product or highlight it 
and choose Open.   
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For a new product the Product field is defaulted to one number higher than the 
highest existing Product ID. 

 

Description 

Used in the Product List and will be listed in the Tank ID Product dropdown when 
setting up your Site(s).  

Maximum Product Allotment 

Sets the global amount for Vehicle/User/Tanker Truck authorized Products. An 
exception appears on the Polling Report if the product is dispensed over the daily 
allotment. This does not lock users out from fueling over the daily limit; it is for 
monitoring and reporting purposes only.  

 



FMPlus User Manual 
Document Version: 5.0 

Chapter 4 Products and Pricing 

 

12/05/2022 © Syntech Systems, Inc. 2014–20122. 37 

Base Cost 

Purchase price of the fuel per gallon, before any adjustments.  

Transaction Limit 

Set this limit to the maximum capacity of the largest tank in your fleet for this 
product. When you add a new vehicle record, the Transaction Limit in that record 
cannot exceed this amount. 

Map To 

Used for credit card customers only and is used to correlate the FuelMaster’s product 
code to the code that needs to be sent to the credit card network for processing. As 
shown above, your company may view the product as Dyed Diesel, but the credit 
card network views the product as Off-Road Diesel. 

Price Level 

There are eight levels of pricing that can be applied for discounts/markups.  These 
levels adjust the total unit costs using a calculation from the Base Cost and 
Adjustment fields.   

NOTE Prices are calculated and attached to Prokee/Smart Card transactions after 
the transactions are downloaded from the FMU into FMPlus. 

Adjustments 

The Adjustment field is a factor in the Total price per gallon. The field can contain a 0 
if no modification to the Total price per gallon is required, and can use 
positive/negative currency or a positive/negative percentage. For example, a retailer 
wanting a $0.10 markup would enter .10 as shown above; this will ensure that all 
Level 1 users will pay 10 cents per unit above cost.  Any combination of the base cost 
and adjustments can be used to meet your needs. All prices must be sent to the FMU 
before they can be used. 
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Chapter 5 Site Configuration 

At the core of the FuelMaster system is the FuelMaster FMU, located on the fueling 
island and used to control and provide access to fuel. Each master FMU can control 
up to eight satellite FMU's. Each instance of a master FMU and its satellites (if any) is 
referred to as a Site.  

Sites using credit card networks must have a dedicated line (phone or network) per 
FMU and can only use master FMUs. 

Each Site is correlated to a set of configuration data in FMPlus and is managed as 
one group.  

Access the Site List by clicking on the Site icon on the FMPlus toolbar, from the 
Tables > Site menu, or hot keys CTRL + F7.  

The Site List displays the Site(s) ID, Name and Type. Each site can be accessed by 
double-clicking the Site name or by highlighting and clicking Open. 

To create a new site, click Add. 
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Site Configuration 

Site information 

Contains Site ID, Name and contact information for the physical site location. Site ID 
and FMU type are required before proceeding to the next section. A Site ID can 
contain up to 4 alphanumeric characters; if fewer, it will be padded with leading 
zeroes. 

 

Tank Listing 

Displays the Tank(s) configured for the site. See Tank Configuration for more 
information. 

FMU Listing 

Displays the FMU(s) configured for this site.  See FMU Configuration for more 
information. 
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Site Configuration options 

Connection type 

There are two types of connections supported by FuelMaster: Phone, and LAN. 
Select the appropriate connection type from the dropdown box and click 
‘Configure’. 

 

Tank Monitor 

The FMU can communicate directly with your TMU and bring back a wide variety of 
details. TMUs communicate serially with the FMU and are queried for information, 
which is returned to the software upon download. 

Type 

The Type option refers to the type of unit the site represents. Fixed units are FMU's 
installed at the fueling island. Select F - Fixed. Mobile units are mounted on fueling 
trucks. Select P – Passive Mobile. 

FMU 

Set the type of FMU installed at your fueling island or Mobile vehicle: Classic, Plus, 
Plus with AIM units, or Plus with AIM Prog FMU type. 

Local Authorization Options 

Controls whether the site receives a lock-in or lock-out list for authorizing Local 
Authorization Credit Cards. A lock-in list holds all credit cards that are authorized to 
receive fuel; any card not listed will not be authorized for fuel. A lock-out list 
authorizes all cards unless a card is listed as unauthorized for fuel. 
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Time Synchronization – with offset 

Utilized to synch the FMU time with the PC time; can be set per site. Offsets can be 0 
to 23 (used for time zone differences). If checked, every time the software goes 
online with the FMU, synchronizes the time at the FMU to the PC time (plus or minus 
the offset).  

Advanced – FMU Settings 

Enable FMU Settings to manage the FMU configuration. See  Managing FMU Settings. 

Connection Configuration  

Phone Connection 

FuelMaster customers can use an analog phone line to communicate with their FMU. 
There are also options available for remote sites to utilize cell phone modems and/or 
phone line extenders.  Enter the FMU phone number and click OK.  

 

LAN Connection 

Uses your existing network to communicate with the FMU via TCP/IP. Enter the static 
IP address assigned to the FMU by your IT Dept. (A static address is a fixed address 
dedicated for the FMU to minimize errors in communications.)  
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Passive and Active FTP Toggle  

When a LAN connection is used to communicate with FMUs, the software can be 
configured to use either Active or Passive FTP on a per site basis.  

 

Tank Configuration 
Tanks provide product for FMU's to dispense. The configuration items and options 
are described below.  
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Tank Capacity 

The maximum fuel capacity of the tank. 

Reorder Limit 

This triggers the FMU to notify the user when the tank has reached or fallen below 
the reorder limit. A message displays on the Polling Report notifying the Central 
Controller to order more fuel after a download has taken place. 

Product 

Select the product to associate with this tank.  

Blended 

A blended tank represents a mixture of two tanks that are combined at fueling.  
Before creating a blended tank, configure two non-blended tanks. This is only 
available if using electronic dispensers at the FMU. 

Maintain Inventory 

If checked, maintains a running calculation of tank inventory based on deliveries, 
adjustments, transfers, stick readings, TMU readings, and fueling transactions. 

Enable Pricing Per Tank 

Check this flag to set site/tank specific pricing versus system-wide pricing.  Pricing 
configuration is handled like the Product Pricing described in Chapter 4. 

Vendor 

This represents the company that provides fuel for this tank. It is used for reporting 
purposes. 

Tank Information 

Displays the latest of each type of inventory transaction: delivery, adjustment, 
transfer, stick reading, and TMU reading, as well as the current quantity read at the 
last download. 
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Inventory Editor 

Deliveries, Adjustments, Transfers, and Stick Reads are all handled through the 
inventory editor interface which allows you to enter/edit inventory related records.   

The Inventory Editor is used to enter, edit, or delete inventory transaction records. 
Check the box to Show Running Balances. To add or edit a record, select the Site 
and Tank desired, and choose the transaction type. Click Add to create a new entry. 
Highlight the desired record and click Edit to change an existing record. This opens 
several different inventory adjustment dialogs that vary slightly for each transaction 
type.  

 

Use the Inventory Adjustment dialogs to enter the date/time and quantity of each 
inventory transaction.  Some, like the Edit Delivery Dialog, have fields specific to 
that delivery type. You can also enter the unit price paid for the delivery. This, in turn, 
is used in the Fuel Costing report to track fuel cost versus what it is sold for. Enter in 
all pertinent information and click OK to save. 
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FMU Configuration 
The FMU Configuration window allows you to establish FMU settings, timers, and 
hose configuration.  

 

FMU Name 

Enter the FMU Name. 

Modem Hours 

Represents the hours during which the FMU modem answers incoming calls from the 
software. 

Totalizer Digits 

Sets the number of digits that can be used to represent totalizer readings: the left 
edit field shows number of digits to the left of the decimal and the right edit field 
shows number of digits to the right of the decimal. 

Valid Key Timeout 

Length of time in seconds the user/customer must complete the transaction 
authorization after inserting a key in the FMU. 

Message Duration 

Length of time in seconds a message prompt is displayed on the FMU's LCD before 
timing out and returning to the previous prompt. 



FMPlus User Manual 
Document Version: 5.0 

Chapter 5 Site Configuration 
 

12/05/2022 © Syntech Systems, Inc. 2014–2022. 46 

Decimal Digits for Onsite 

Specifies the number of digits printed on the onsite printer for transaction quantity 
information. 

Zero Quantity Shutdown 

The number of zero quantity transactions a hose can execute consecutively before 
the hose is shut down. This prevents fuel being dispensed when no quantity is 
recorded, perhaps because the pulser in the dispenser is failing, or has failed, and 
needs to be replaced. 

Julian Date Rollover Hour 

Specifies the time at which the day end/begins for accounting purposes.  Example: 
Download takes place every day at 8:00 am and the Julian Date Rollover is set to 8. 
This setting will change the date and time of the transactions by 8 hours using 8:00 
am as midnight to start a new day of transactions. If someone fuels at 7:30 am and 
then a download takes place at 8:00 am with the current setting 8, the 7:30 am 
transaction will have a date/time as 11:30 pm the previous day. 

Each FMU at your Site(s) needs to be configured separately under the Site 
Configuration. This includes the master FMU and any satellite FMUs. 

Online 

When an FMU configuration is complete, click Online > Upload to send the 
information to the FMU. 

If the FMU has already been configured or to activate Site FMU Settings, click Online 
> Download to send configuration information to FMPlus. 
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Hose Configuration 
Hoses are tied to pump positions in the FMU pedestal. Each FMU can control up to 
eight physical pump positions and can therefore have eight hoses.  

 

Multi-Product Dispensers (MPD) can be interfaced with the FMU using an Omega 
Jr./PIE box. The PIE box is essentially a translator that allows the FMU to issue 
commands to the Electronic Dispensers’ computer modules.  In this scenario, fuel 
control is not handled mechanically, but instead done electronically.  

Hose Types: 

Mech - Mechanical Hoses 

Configure one hose at a time for mechanical dispensers and mechanically controlled 
electronic dispensers.  

MPD/Electronic Hoses 

MPD's and Electronic Dispensers using PIE boxes use all the Mechanical settings but 
also use the PIE setting. This is the electronic address that correlates to the fueling 
position being controlled.  For MPD the hose position is one side of the dispenser or 
fueling position. Each FMU can control up to eight fueling positions. 

PHL (Pump Handle Sensing) 

Pump Handle Sensing can be used for starting and/or ending transactions.  This 
MUST be set to how the position is wired in the dispenser. 
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Div Ratio 

Divide Ratio correlates to the pulser divide rate - the number of pulses generated for 
each integral unit of issue dispensed.  Common settings are 100:1 or 10:1. 

NPT (No Pulse Timeout) 

Amount of time allowed from the transaction authorization until the transaction is 
stopped because dispensing did not occur. 

PFT (Pump Finish Timeout) 

Amount of time after pulses cease before the FMU completes the transaction. 

Type - Configure 

For a "Mech" hose, Configure opens the Mechanical Grade Positions dialog box.  For 
an "MPD" hose, Configure opens the MPD Grade Positions dialog box.   

Mechanical Grade Positions 
For Mechanical Hoses, there can only be one grade per hose position. To configure 
the grade, select the appropriate tank from the dropdown box. 

Verify that the Product automatically displayed when the tank is selected is the 
correct one or correct any issue in the tank configuration interface. Click OK.  
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MPD Grade Positions 
For MPDs, you can configure up to eight grade positions for each individual hose or 
fueling position. To clarify, the hose position is the side of the dispenser you wish to 
control, and the grade positions represent the different products available through 
that dispenser.   

 

To configure the grade positions, select the tank for each position and then configure 
the PIE addresses for each. When a position is filled, the next position becomes 
available. The PIE addresses are established by the dispenser and are usually 
sequential from 1 to 8. Verify the Product box is correct when selecting tanks.  

NOTE The AIM Nozzle ID (ANID) identifies the fueling hose tag for the AIM module. 
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Chapter 6 Customers, Vehicles, & Users 

FMPlus has three primary ways to gain access to fueling data for billing purposes: by 
Customer, Vehicle, or User. Of these, Vehicles and Users can be encoded on keys or 
cards and used to access the FMU. 

There are several more layers of authorization and billing ability in FMPlus, such as 
Agency, Department and Usage. Customizable fields (Miscellaneous fields covered in 
Chapter 3) can also be used to break out accounting data in even more detail. 

Customers 
Access the Customer list by clicking the Cust icon on the FMPlus toolbar, by 
selecting Tables > Customer, or by hot keys CTRL + F8.  

 

Customer records are the top billing level of the FuelMaster package. The Customer 
List displays the Customer ID, Name, and Phone number. 

Customer information can be accessed by double-clicking or by highlighting and 
clicking the Open button. 

Click Add to add a new customer and its detailed information. 
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Customer ID 
The Customer ID window is used to enter all information pertinent to a customer.  

 

Customer ID 

The Customer ID contains up to 9 alphanumeric characters and will be automatically 
padded with zeroes (to the left). This field identifies which Vehicles and Users 
correspond to a specific customer. If you do not wish to use this option, you can turn 
off the Require Customer ID setting as shown in Chapter 3, System Tab. 

Customer Information 

The Customer ID is a unique 9-character identifier for the customer in FMPlus. Use 
the Customer Name field to more completely identify the customer for users of the 
system. 

Price Level 

The Price Level can be set for each customer for their vehicles/users. This is a global 
setting for each customer but can still be adjusted per vehicle/user if needed. For 
more info on Price Levels, see Chapter 4. 
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Vehicles 
The list of Vehicles can be accessed by clicking the Vehicle icon on the FMPlus (Fig 
3.1) toolbar, by selecting Tables > Vehicle, or by hot keys CTRL + F5.  

 

Once Customer records have been created, or the option turned off, Vehicle records 
can be created. The Vehicle record contains information about the vehicle, the 
Customer, and products authorized for the vehicle. Each vehicle can be accessed by 
double-clicking or by highlighting and clicking the Open button. New Vehicles can be 
added by clicking Add. 

Vehicle Record 
The Vehicle Record contains five tabs unless the system is configured as a Passive 
System (AIM). Passive Systems are covered in Chapter 9. 

If the system is VVI or UKO, the Vehicle tabs will not have Products or Prokee/Smart 
Card tabs and you will not be able to encode Prokees or Smart Cards here.  
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Vehicle General Tab 

Various fields are available for billing, maintenance, and description. 

Vehicle ID 

The Vehicle ID is encoded onto the Prokee/Smart Card to identify the vehicle upon 
fueling. The ID can be numeric only or alphanumeric depending on the System Type 
described in Chapter 1. 

Vehicle Description 

Describes the vehicle and is primarily used for reporting. 

Agency 

The Agency field is provided by FuelMaster as a standard accounting category. This 
field is encoded on the key, can be up to 5 alphanumeric characters and can also be 
prompted for during a fueling transaction.  

NOTE The prompt option can only be enabled by a Syntech Certified Technician or 
CSC Technician who can be contacted via phone 1-800-888-9136 ext. 2. 

Also ties the vehicle to an agency for group authorization purposes.  

Encoded 

Status of whether this record has been encoded onto a Prokee or Smart Card. 

Customer ID 

Ties the Vehicle ID to a Customer for billing or reporting purposes. 

Customer Name 

Automatically filled when a Customer ID is selected from the dropdown list. 

Vehicle Information Fields 

Use the Vehicle Year, Vehicle Make, and Vehicle Model field to provide additional 
information about the vehicle. 

Passive Status Box 

This box only appears if this is an AIM selected vehicle. It shows the programmed 
status of the vehicle record to the AIM. When appropriate, the record also has a box 
that denotes the vehicle is not enabled as an AIM vehicle. 

Authorized: 

• Prokee - if checked and sent to the FMU this vehicle record’s 
corresponding Prokee is authorized; if unchecked and sent to FMU the 
Prokee is unauthorized at the FMU.  
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• AIM – Only shows if AIM is enabled. If checked and sent to the FMU this 
vehicle record’s corresponding AIM is authorized; if unchecked and sent to 
FMU the AIM is unauthorized at the FMU. 

• Keypad – Only shows if the system type is Keyless. If checked, the ID is 
authorized to start Keyless transactions at the keypad. 

NOTE Removing authorization by unchecking the Prokee or AIM box preserves 
reporting ability on vehicle transactions. Deleting, and potentially reusing 
the Vehicle ID, can lead to problems and inaccurate information in the 
database. 

Vehicle Products Tab 

One of the benefits of having a FuelMaster System is to make sure vehicles only 
dispense the products assigned to the vehicle to protect the vehicle from damage 
and the vender from theft.  

 

Product 

Select one, or up to eight, Products from the Product dropdown lists to be assigned 
to the vehicle. 

Product Description 

Displays the description of the selected product and is automatically filled when a 
product is selected. 

Daily Product Allotted 

Track a vehicle’s normally expected one day usage. This can be set to twice the 
transaction limit if, for example, the vehicle might fuel twice in one day. The option to 
cutoff the user from overage can be enabled at the FMU; otherwise, an overage is 
tracked using an exception message in the Polling Report. 
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Transaction Limit 

Maximum amount of fuel allowed per fueling transaction. Typically set to the 
vehicle’s fuel tank capacity. The transaction ends at the specified amount per vehicle 
per transaction. 

Price Level 

Level at which the vehicle fuel is billed; set from the dropdown list. The Price Level is 
applied to the quantity upon a download from the FMU to arrive at the total price. 

Match Customer Price Level 

If checked, this record will be linked to its corresponding Customers Price Level. 

Delete 

Allows the operator to click Delete to remove a product from the vehicle record.  

Vehicle Prokee/Smart Card Tab 

Configures the Prokee/Smart Card options at the FMU when a key is used, and 
shows the most recent status and encoding information for the vehicle. 

 

Odometer 

When checked, the Prokee/Smart Card prompts for an odometer reading at the FMU 
keypad to complete fueling. 

PIN 

When checked, the Prokee/Smart Card prompts for a PIN at the FMU keypad. The 
PIN is the last four digits of the Prokee Internal Number. You may use the Read 
Prokee button on the toolbar to see the Prokee Internal Number. The Prokee tab also 
shows the Prokee Internal Number for a Vehicle or User if available. 
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User ID 

When checked, the Prokee/Smart Card prompts for a User ID. For some system 
types, like the VMN system, this is automatically required and cannot be disabled. 

Receipt 

Like the other Prokee/Smart Card options when checked, the user is asked if they 
would like a receipt of the transaction. Credit card transactions provide a receipt 
regardless of this setting. 

Status Fields 

• Key Type – Vehicle, User, Tanker Truck, Supervisor, Manual Issue 
• Reissue Count – Number of times the record has been issued to a new key 
• Date Reissued – Date key was last re-encoded 
• Encoded – Status of record being encoded or not 
• Date Encoded – Date key was initially encoded 
• Authorized – Vehicle Key/Smart Card is authorized or unauthorized 
• Date Authorized – Date the key/Smart Card was last authorized 

PIN & Internal Key Number 

The internal key number is assigned when the key is encoded. The last four digits of 
the internal key number are the PIN. It cannot be chosen by the Central Controller as 
it is automatically assigned when the Prokee is encoded. 

Vehicle Misc Tab 

Define the labels for the miscellaneous fields in Configuration > System. These fields 
can be used in reporting and Custom Exports.  
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Organization 

This accounting field is not encoded on the key; can be three alphanumeric 
characters. 

Usage 

Also not encoded on the key; can be six alphanumeric characters. 

Date Service Began 

Displays the date the key record was created. 

Miscellaneous Fields 

The five potential miscellaneous fields can be used for additional accounting 
information. These fields can be up to 20 alphanumeric characters. 

Vehicle Odometer Tab 

Information regarding the Odometer and PM Maintenance are created and stored in 
this tab.  

 

Current Odometer 

Displays the current mileage of the vehicle if entered while fueling. 

Date Odometer Read 

The date of the last odometer reading if entered when fueling. 

Fuel Range 

Distance the vehicle can travel on one full tank. An exception displays on the Polling 
Report if the vehicle goes outside the range. The message is also invoked if the 
vehicle has fueled offsite causing the odometer to be out of range. If a vehicle is 
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often transient, setting this range higher is suggested since offsite fueling will be 
taking place. 

Expected Efficiency 

Expected miles per gallon (MPG) for the vehicle. 

Preventative Maintenance 

Checking this box allows you to track Preventative Maintenance for this vehicle or 
equipment. 

PM Range 

Number of miles the vehicle can go between preventative maintenance servicing 
such as oil changes.  

PM Notification   

Sets the number of miles prior to reaching the PM Range for notification.  

Reports > Preventative Maintenance > PM Over Due or PM Over Notice shows 
when vehicles are due for preventative maintenance and need to be serviced.   

Next PM Reading 

Set when the record is created to flag for servicing; also reset when the vehicle has 
completed servicing. 

Users 
The list of Users can be accessed by clicking the User icon on the FMPlus toolbar, by 
selecting Tables > User, or by hot keys CTRL + F6.  

 

The User List operates similarly to the Vehicle List, showing Users who are authorized 
to fuel vehicles and general information on each user. 
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User ID 

The User dialog in this example contains one tab as the system type is VMN. Other 
System Types may display additional tabs that operate similarly to the tabs in the 
Vehicle ID section.  

 

Users General Tab 

Basic information fields describe the Users information.  

User ID 

The User ID is either a manual entry at the FMU or can be encoded onto a 
Prokee/Smart Card or Proximity card. This depends on the System Types as 
described in Chapter 1. 

Last, First, MISC, Middle Initial 

Used to describe the User; used for reporting. 

Agency & Department 

Associate an Agency or Department to the User for group authorization purposes. 

Customer ID & Customer Name 

When you select Customer ID from the dropdown box, the Customer Name auto-fills. 
This must be selected before entering other fields. 
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Agencies, Departments, and Organization 
Vehicles, Users, and Utility Keys can be grouped for authorization and billing by 
Agency, Department, and Organization, as well as by Customer. 

 

Agency, Department, and Organization can be accessed through the Tables menu.  

Agencies  

Agency List 

Select Tables > Agency… from the menu to access the Agency List. 

Use the list to Add, Delete, or Open Agency records. 

Access Agency information by double-clicking on a record or highlighting it and 
clicking Open. 

 

NOTE An Agency cannot be deleted from the system if it is associated with any 
vehicle or user. 
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Agency New 

Each agency must have an agency Type and Name.  Description is optional. 

The name field supports up to 5 characters. 

 

Agency Types 

Each Agency value must be unique and can only be associated with one record type; 
User, Vehicle, or Utility. 

 

Different Authorization checkboxes display depending on the System Type and 
Agency Type selected.  

Once added, Agencies are available via a dropdown box for Vehicles, Users, and 
Utility Keys. 

 
  



FMPlus User Manual 
Document Version: 5.0 

Chapter 6 Customers, Vehicles, & Users 

 
 

12/05/2022 © Syntech Systems, Inc. 2014–2022. 62 

Departments 
Department List 

Select Tables > Department… from the menu to access the Department List. 

Use the list to Add, Delete, or Open Department records.  

 

Access Department information by double-clicking on a record, or highlighting it and 
clicking Open. 

NOTE A Department cannot be deleted from the system if it is associated with any 
user. 

Department Entry 

Each department must have a Name, up to 6 characters.  Description is optional.  

Different Authorization checkboxes display depending on the System Type. 
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Organizations 
Organization List 
Select Tables > Organization… from the menu to access the Organization list.  

 

Use the list to Add, Delete, or Open Organization records. 

Access Organization information by double-clicking on a record or highlighting it and 
clicking Open. 

NOTE An Organization cannot be deleted from the system if it is associated with 
any vehicle. 

Organization 

Each Organization must have a Name, up to 3 characters.  Description is optional. 

 

Different Authorization checkboxes will be displayed depending on the System 
Type.   
 

  

Authorization by Group 
Vehicle, Users, Utility Keys, and AIM vehicles can be authorized or de-authorized in 
groups by Customer, Agency, Department or Organization. 
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Regardless of the group type, group authorization is accomplished in the same way.  

Setup associations 

For example, to authorize Vehicles by Agency, first create Agency records.  To 
associate an Agency with Vehicles, set the Agency type to “Vehicle”. 

 

Next, associate vehicles with agencies by setting the Agency value within the Vehicle 
record. 

NOTE The Agency has been set to OVER, and the vehicle is authorized.  

 

  

 
  



FMPlus User Manual 
Document Version: 5.0 

Chapter 6 Customers, Vehicles, & Users 

 
 

12/05/2022 © Syntech Systems, Inc. 2014–2022. 65 

Authorize/De-authorize 

You may authorize or de-authorize an entire group of records by unchecking the 
appropriate box within the group record. 

In this example, all vehicles associated with the agency, Overton, will be de-
authorized. 

   

To authorize/de-authorize a group of records, click the appropriate checkbox and 
click OK.  

Once the change has been applied, you can see the effect by viewing any record 
with the associated group type. In this case, the record with the agency OVER has 
been de-authorized. 
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Multiple Associations 

It is possible for a record to have multiple associations. For example, in a VMN 
system, a vehicle record may have an associated Agency, Customer, and 
Organization. 

The last change to an authorization will take precedence over any previous change, 
regardless of the group associations.  

 

For example, all vehicles within an Agency group will be authorized (or de-
authorized) if the associated Agency was the last to be changed, even if some or all 
vehicle records are also associated with Customers.  

Allowed Associations - Groups  

Not all groups are available for all record types.  The specific options available 
depend on the System Type setting, and for Agencies, the Agency Type setting. 

This is a list of available group types by record type. 

  

 

 

 Vehicle +AIM 
Programmer AIM Vehicle User 

Utility (Tankers, 
Supervisors, Manual Issue) 

Agency X X X X 

Customer X X X X 

Department   X  

Organization X X  X 
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Authorization Summary 

In addition to being used to authorize or de-authorize groups of records, the 
authorization checkboxes for each group type provide a quick summary of 
authorization statuses. 

 

The three statuses are: 

• Checked – All associated records are authorized. 
• Grayed/Checked – Some of the records are authorized, or no associations 

exist.  This is the default status. 
• Unchecked – All associated records are unauthorized.  

 



FMPlus User Manual 
Document Version: 5.0 

Chapter 7 Prepaid and Discount Cards 

 
 

12/05/2022 © Syntech Systems, Inc. 2014–2022. 68 

Chapter 7 Prepaid and Discount Cards 

FMPlus provides the option to offer various discounts for preferred customers based on 
either individually encoded prepaid cards or Prokees, or by discounting specific credit 
cards. 

The Prepaid option is used primarily for those customers who want to pay for fuel 
ahead of time instead of being billed afterwards or do not want to use credit cards. 

The Discount Card is designed to allow retail sites to reward their most frequent and 
high-volume customers by providing a discount with the same high level of 
convenience they expect from their credit card.  Both transaction types are billed at the 
FMU when fueling occurs, so updating the FMU’s pricing is important. 

NOTE This option requires customization. Call the Syntech Systems, Inc.’s CSC 
Helpdesk at 1-800-888-9136 ext. 2 to enable these options in your software. 

Card Owners 
To access Card Owners, select Tables > Card Owners from the menu. 

 

Prepaid and Discount Credit Cards are grouped together under Card Owners so the 
two record types can be managed at a higher level. For example: a company has 3 
pilots with credit cards whom receive a discount and has 2 standby part time pilots 
whom use prepaid keys. The discount cards and prepaid cards can be tracked under 
the company account and individually.  
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Card Owner List 

The list displays card owners, card owner names, and the date each account was 
created.  

 

Card Owner Info 

Card Owner ID information window is used to enter contact information regarding the 
account. 

There are two card type tabs: Discount Cards and Prepaid Cards.  

 

The information in these records may hold sensitive data, such as credit card numbers. 
Even though credit card numbers are encrypted in FuelMaster, restrict access to this 
feature to employees who need access. 

Card Owners can have multiple discount cards and prepaid keys in any combination 
required.  
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NOTE Discounts by credit card types, also known as branded discounting, are not 
handled through the software. This option must be enabled directly in the FMU 
by a FuelMaster Certified Technician or CSC. It is only available for certain card 
types and certain credit card networks. Call Syntech Systems, Inc.’s CSC at 1-
800-888-9136 ext. 2 to enable the option if you have purchased the 
customization. 

Discount Cards 
Enter the credit card information.  

 

Owner ID 

Associates the card to a card owner for accounting purposes. 

Beginning Date 

Date the record was created. 

Already Encrypted 

Select No if the card number being entered has not been hashed by FMPlus. Select Yes 
when entering data from a FuelMaster onsite printer or database, which displays and 
stores credit card numbers in an encrypted format. 

Card ID 

Enter the credit card number in this field. If the number is already encrypted then it will 
not change, otherwise it will be masked immediately upon entry. 

CC Expiration Date 

This is used for identification purposes only; this information is not required at the FMU 
nor sent to the FMU by the software. 
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Partial ID 

Shows the last four digits of the card number which display on reports and receipts. 
This is useful to match receipts from customers with the card record. 

Apply Discount 

Check to apply a discount to this card. 

Price Level 

Set price level to the discount you would like to give the card user. 

Brand 

Lists available card types that can be assigned to the card; select Unknown/Other if 
your card is not in the list. 

Prepaid Keys 
The General tab displays the information about the prepaid key.   

 

Create Prepaid Key 

 1. Create the record. 

 2. Authorize it. 

 3. Apply Balance. 

 4. Encode Key. 

 5. Send list to FMU. 
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Prokee ID 

The ID can be 8 alphanumeric characters and is used to identify the key at the FMU 
when the list is uploaded. 

Price Level 

Set the price level to be applied when the key is used. 

PIN 

If checked, the four-digit PIN number, generated when the Prokee is encoded, will be 
prompted for and verified by the FMU. 

Authorized 

Check/uncheck to authorize/de-authorize the prepaid record for fueling; stamps the 
date the key was authorized/de-authorized. 

Encoded 

Checked when a Prepaid Prokee has been encoded. The date/time the key was 
encoded or reissued displays next to the checkbox. 

Internal Key Number 

Generated when the key is encoded to identify the key at the FMU. 

Owner ID 

Associates the key to a card owner for accounting purposes. 

Creation Date 

Date the record was created. 
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Balances Tab 

Prokee Balance in Database 

Displays the current balance in the database; you can also add and deduct monies from 
the Prokee.   

 

Unclaimed outstanding credit 

A balance left after a fueling transaction. For example, a user preauthorizes $30 of fuel 
but pumps $29.50; the outstanding balance of $0.50 displays in this field after the 
transaction downloads. If an outstanding credit resides in the FMU, the credit can be 
applied back to the key when the user pumps more fuel. Once the credit has been 
downloaded, it can only be credited back to the key through the software.  
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Chapter 8 Utility Keys 

There are three types of Utility Keys in FMPlus: Tanker Truck, Supervisor, and Manual Issue. 
They are referred to as Utility keys because they serve more of a maintenance function than 
normal keys. They also share the same list within the software and FMU to conserve space. 
Because they are managed in the same list, they cannot have the same ID as any other 
Utility Keys in the list. 

Tanker Truck Keys 
Access the Tanker Truck List by clicking Truck on the FMPlus toolbar, by selecting Tables > 
Tanker Truck from the menu, or by hot keys CTRL + F9.  

A Tanker Truck key has two purposes: first, to upload transactions to an FMU from a Mobile 
Unit for download and to upload lists from the FMU to the Mobile Unit. Secondly, it is used 
to transfer fuel from an FMU at a fixed fuel island to the Tanker Truck's storage tank. 

Tanker Keys should not be used to fuel the tanker truck vehicle itself. A vehicle key should 
be issued for fueling the Tanker Truck. 

 

Tanker Truck List 

Displays the current keys in the database and whether the record has been encoded to a 
key. 
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General Tab 

Various fields are provided to identify the Tanker. Before a Tanker Truck key can be created 
a Passive Mobile Site must be created.  

 

Tanker Truck ID 

Identifies the Tanker record; can be 8 alphanumeric characters.  

Description 

Describes the Tanker and is primarily used for reporting. 

Truck Year 

Year the truck was manufactured. 

Site ID 

Ties the Tanker to the Passive Mobile Site that was created for transferring fuel. 

Site Name 

Automatically fills when the Site ID is selected to identify the Mobile Site. 

Customer ID 

Assigns the Tanker Truck to a Customer for accounting purposes. 

Customer Name 

Automatically fills when Customer ID is selected. 

Encoded 

Displays whether the Tanker key has been encoded. 
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Authorized 

Authorizes or de-authorizes the tanker key for transferring fuel. This area will be grayed out 
until the key has been initially encoded. 

Tanker Products Tab 

One of the benefits of a FuelMaster System is to ensure a Tanker only gets the products 
intended for the Tanker. This protects the Tanker from damage to itself, damage to other 
vehicles receiving fuel from the Tanker, and the purchaser from theft.  

 

Product 

Select a Product from the dropdown list to assign to the Tanker. 

Product Description 

Displays the description of the selected product and automatically fills when a product is 
selected. 

Daily Product Allotted 

Tracks when a Tanker exceeds expected distributions in a day’s time. This is usually set to 
twice the transaction limit. An option to cut off the user from overage can be enabled; 
otherwise, the overage causes an exception message in the Polling Report. 

Transaction Limit 

Maximum amount of fuel allowed per fueling transaction. Typically set to the tanker 
capacity. 

Price Level 

Select the Level at which the Tanker is billed from the dropdown list. The Price Level is 
applied to the quantity upon a download from the FMU to arrive at the total price. 
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Match Customer Price Level 

If checked, this overrides the Product's Price Level with the Customer's Price Level. 

Tanker Prokee/Smart Card Tab 

Configures the Prokee/Smart Card options the user receives at the FMU when the key is 
used. Shows status and encoding information for that record. 

 

User ID 

If checked, prompts for a User ID. Depending on the System Type, like VMN, this may be 
automatically required and cannot be disabled. 

PIN 

Sets the Prokee/Smart Card to require the user to enter a PIN number at the FMU. The PIN 
number is the last four digits of the Prokee Internal Key Number. 

Receipt 

When checked, prompts user/customer to print a receipt of the transaction. 

Status Fields 

• Prokee Type – Vehicle, User, Tanker Truck, Supervisor, Manual Issue 
• Date Reissued – Date key was re-encoded 
• Encoded – Status of record - encoded or not encoded 
• Date Encoded – Date key was first initially encoded 
• Authorized – Status of record - authorized or unauthorized 
• Date Authorized – Date the key was last authorized 

Reissue Count 

Records the number of times the record is issued a new key. If a key is reissued, the new 
key has a new Internal Key Number; the unavailable key's Internal Key Number is placed on 
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the unauthorized list. If found or stolen, the original key will not be authorized to receive 
fuel. 

PIN Number & Internal Key Number 

The internal key number is assigned when the key is encoded. The last four digits of the 
internal key number are the PIN. 

Tanker Misc Tab 

These fields can be used in accounting and reporting for Tanker fueling. The miscellaneous 
fields can be defined in Configuration > System. 

 

Agency 

The Agency field is encoded on the key, can be up to 5 alphanumeric characters, and can 
also be prompted during a fueling transaction.  

NOTE The prompt option can only be enabled by a FuelMaster Certified Technician or 
CSC whom can be contacted via phone 1-800-888-9136 ext. 2. 

Organization 

This accounting field is not encoded on the key; can be 3 alphanumeric characters. 

Usage 

An accounting field not encoded on the key; can be 6 alphanumeric characters. 

Date Service Began 

Displays the date the key record was created. 

Miscellaneous Fields 

The five miscellaneous fields can be used for added accounting. These fields can be 15 
alphanumeric characters. 
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Supervisor Keys 
Access the Supervisor List by clicking the Super icon on the FMPlus toolbar or by selecting 
Tables > Supervisor from the menu.  

Displays the keys currently encoded. FMPlus ships an encoded Supervisor Key with the 
FMU, so the FuelMaster Certified Technician can initially configure the FMU.  

 

The Supervisor key is used to configure and troubleshoot at the FMU via the Supervisor 
menu.  

Supervisor General Tab 

Supervisor ID 

Enter an ID for the Supervisor; can be 8 alphanumeric characters. 

 

Customer ID 

Assigns the Supervisor key to a Customer for accounting reports. 

Prokee Options 

PIN and Receipt can be prompted for by the FMU. 

Status Fields 
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• Key Type – Vehicle, User, Tanker Truck, Supervisor, Manual Issue 
• Date Reissued – Date key was re-encoded 
• Encoded – Status of record being encoded or not 
• Date Encoded – Date key was initially encoded 
• Authorized – Vehicle Key/Smart Card is authorized or unauthorized 
• Date Authorized – Date the key/Smart Card was last authorized 

Authorized 

This check box is available after the key is encoded; removing the check mark de-
authorizes the key. 

Supervisor Misc Tab 

Used to configure miscellaneous settings that can be used to account for Supervisor 
Access. The miscellaneous fields can be defined in Configuration > System. Each field listed 
below can be used in reports and Custom Exports.  

 

Agency 

This field is encoded on the key; can be up to 5 alphanumeric characters, and can also be 
prompted during a fueling transaction.  

NOTE The prompt option can only be enabled by a FuelMaster Certified Technician or 
CSC whom can be contacted via phone 1-800-888-9136 ext. 2. 

Organization 

An accounting field not encoded on the key; can be 3 alphanumeric characters. 

Usage 

An accounting field not encoded on the key; can be 6 alphanumeric characters. 
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Date Service Began 

Displays the date the key record was created. 

Miscellaneous Fields 

The five miscellaneous fields can be used for added reporting. These fields can be 20 
alphanumeric characters. 

Manual Issue Keys 
Select Tables > Manual Issue from the menu.  

 

Manual Issue Keys are used in a variety of scenarios where normal fueling operations are 
not possible or too time restrictive. This key allows onsite personnel to authorize a 
transaction without entering any specific accounting information (although the option to do 
so is available).  

Manual Issue Keys are typically used when a driver key is unavailable, and it does not make 
sense to encode another key. Another example is in an emergency where out of area 
vehicles, such as Ambulances or Fire Trucks, can be fueled and the amount of fuel 
dispensed can still be tracked. 

When a transaction is authorized using a Manual Issue Key, the user is prompted to enter 
their User ID and/or Vehicle ID depending on the system type and the option settings in the 
FMU. For more information on the way the Manual Issue Key behaves at the FMU, see the 
Site Operations Manual. 
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Manual Issue List 

Displays Manual Issue Keys currently encoded.  

 

Manual Issue General Tab 

Manual Issue ID 

Enter an ID for the Manual Issue Key; can be 8 alphanumeric characters. 

 

Customer ID 

Ties the Manual Issue Key to a Customer for accounting reports.      

Prokee Options 

PIN and Receipt can be prompted for by the FMU. 

Status Fields 

 Key Type – Vehicle, User, Tanker Truck, Supervisor, Manual Issue 

 Date Reissued – Date key was re-encoded 

 Encoded – Status of record being encoded or not 

 Date Encoded – Date key was initially encoded 

 Authorized – Vehicle Key/Smart Card is authorized or unauthorized 
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 Date Authorized – Date the key/Smart Card was last authorized 

Authorized 

This check box is available after the key is encoded; removing the check mark de-
authorizes the key. 

Manual Issue Misc Tab 

Used to configure miscellaneous settings to account for Manual Issue Key fueling. The 
miscellaneous fields can be defined in Configuration > System. Each field listed below, can 
be used in reports and Custom Exports. 

 

Agency This field is encoded on the key; can be up to 5 numeric characters; and can also 
be prompted during a fueling transaction.  

NOTE The prompt option can be enabled by a FuelMaster Certified Technician or CSC 
who can be contacted via phone 1-800-888-9136 ext. 2. 

Organization 

An accounting field not encoded on the key; can be 3 alphanumeric characters. 

Usage 

An accounting field not encoded on the key; can be 6 alphanumeric characters. 

Date Service Began 

Displays the date the key record was created. 

Miscellaneous Fields 

These five miscellaneous fields can be used for added accounting; can be 15 alphanumeric 
characters.
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Chapter 9 AIM Software Operations 

The Automotive Interface Module (AIM) system controls access to fuel with RFID 
technology that communicates between fuel nozzle and filler neck for a specific vehicle. 

AIM also provides data directly from the vehicle’s On-Board Diagnostic (OBD) computer, 
accurate odometer and hour meter readings. 

NOTE This chapter covers the software portions of our AIM passive fueling system. 
Installation and site operations instructions can be referenced in the AIM 
Installation and Site Operations Manuals. 

AIM Programming 

AIM Programmer List 

Access the AIM Programmer list from Tables > AIM Programmer. 

The AIM Programmer key allows programming AIM modules at the FMU and should only be 
issued to operators allowed to change AIM record data and installations.   

  

NOTE AIM Programmer Keys may only be used at the FMU when the Plus with AIM Prog 
FMU type is set for the Site. 
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The AIM Programmer List displays the Programmer ID, Name, and if the key has been 
Encoded.  

Each record can be accessed by double clicking the desired record or by highlighting the 
record and clicking Open. 

 
       

This key is also used when AIM modules change vehicles and need to be programmed with 
a new Vehicle record.  

AIM Programmer General Tab 

Displays information to identify the operator issued the key.  

 
 

If Authorized Prokee is checked, the key is authorized. If the check is removed, the key is 
unauthorized once the Authorization List is sent to the FMU Sites. 
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AIM Programmer PROKEE Tab 

Displays the key information such as the Prokee Type, Reissue count (number of times the 
key has been replaced), and date of last reissue, date the key was initially Encoded. If the 
key is currently Authorized, the date the key was Authorized, Internal Key Number, and 
PIN Number will appear (used if the PIN checkbox is checked). 

 

AIM Vehicle Record 
To add AIM features with additional options to a vehicle record, enable the AIM checkbox. 

 
 

A Passive Status dialog on the Vehicle General tab shows the status of the AIM module.  
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AIM Tab 

Contains Info, Options, Notes, and Status information for the AIM module.  

Selected Options are sent through FMPlus to the AIMs.   

 

The Status of the module is displayed in the bottom section of the tab. There are three 
different AIM status descriptions: 

 AIM not Enabled – the vehicle record is not enabled as an AIM vehicle. This message 
displays if the Check to install AIM box on the General tab of the vehicle record is 
not checked. Check box and click OK to save; then reselect the record.  

 AIM Program Pending – The AIM vehicle record is enabled and ready to be 
programmed but is pending programming of the AIM module on the desired vehicle 
at the fuel site. The record will not exist at the site until the AIM Programming List 
has been sent to the sites.   

 AIM Program up to date – The AIM is installed and programmed. No new 
programming is pending. The AIM module has been programmed in the specified 
vehicle. 
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AIM Chronometers Tabs 

Use the Chronometers tabs to track Engine Idle Time, Engine Run Time and PTO Time.  

 

Up to three Chronometers can be configured per AIM in each vehicle record. The 
Chronometer interface may be analog and/or OBD. The AIM does not go to sleep when any 
configured chronometer is active; and the AIM awakens when any configured chronometer 
becomes active. A Preventative Maintenance (PM) option can be configured for each 
chronometer. When the PM option is checked, set the PM Range, the PM Notice, and next 
PM Reading. 

AIM OBD Trouble Codes Tab 

OBD trouble codes are read when the vehicle stops in range of an FMU if the engine has 
been running at least one hour since the last trouble code report was sent.  

 

Run Reports > OBD Data > Active Trouble Codes to track vehicle trouble codes. 
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AIM OBD Statistics Tab 

This section covers a wide range of different readings from the OBDII port to show the 
statistics of the vehicle.   

These fields provide information on how well the vehicle is being maintained. 

 

AIM Interface Tab 

Records the AIM configuration as reported from the AIM back to FMPlus. 

 

AIM supports a premium feature that detects and automatically captures the vehicle 
odometer directly for light duty CAN vehicles. When implemented, this feature collects and 
reports the vehicle odometer to FMPlus where it is shown in the Vehicle Record and various 
reports. The Dash Odometer feature requires purchase of a customization to FMPlus. See 
Dash Odometer for AIM2.4 & AIM Titanium for details. 
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AIM Bulk Installation 

Install AIMs on Fleet Modal 

Access the Install AIMs for Fleet modal from Operations > Install AIMs on Fleet. 

 

The Install AIMs for Fleet modal allows installation and uninstallation of AIMs on the entire 
fleet of vehicles.  This feature is ideal  for situations when installing AIMs one by one via the 
Vehicle General tab would be time consuming. AIM Feature and Chronometer Settings may 
be toggled prior to install to create a uniform configuration for the Fleet. 
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Chapter 10 Communication with the FMU 

FMPlus primarily interacts with the FMUs by uploading site configurations, prices and 
authorization lists to said units and downloading transactions from them. In addition, 
interaction is required for Prepaid operations, Discount Credit card operations, AIM 
programming, TMU interfacing, Credit Card batch reports, and Local Authorization lists. 
When any of these items are configured in FMPlus, they must be sent to the FMU before the 
options are active at the fuel island. 

Most online communications are handled through the FM Download Service(s). Each 
FMPlus instance can run a FM Download Service. The Service allocates tasks between 
Services to increase efficiency and reduce overall download times. It does not include 
communication with the FMU via the FMU Console. For more information, see:  

 MultiPoint Download Service (MPDS) 

 MPDS Online Client Permissions 

Online Communications 
To access communications, click Online on the FMPlus toolbar, by Operations > Go Online 
with FMU’s, or by hot keys CTRL + L.  

Online Client 

The Online client opens on the Manual Download tab.  

Select Sites in the list box. Select Download Options. Click Connect to begin an online 
session. 
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Disconnect is active during an online session and can be clicked to interrupt the session. 
Allow 60 seconds for the disconnection to complete before closing any windows. 

The Download Options vary by System Type. 

Auto Download 

Auto Download is used to begin communication with the FMU at predefined times using the 
options selected on the Auto Download tab. The frequency of the Auto Download can be 
done daily, weekly, once, or in periodic time intervals.  

To enable an Auto Download, set the schedule options and click Schedule.   

Stop will interrupt the online session. 

Remove Schedule deletes an Auto Download. 
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Service Requests 

Service Requests shows pending online sessions. 

 

Archived Messages 

Once online sessions have completed, they are shown on the Archived Messages tab.  
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Service Configuration for Download Service 
To stop or start the Download Service on the Central Controller, click System > Service 
Configuration.  

 

Highlight the FM Download Service, then click Run Service to start or Stop Service to stop 
the Download Service running on the Central Controller. You will need to do this on each 
machine running MultiPoint Download Services (MPDS). 

 

Only use Install Service or Uninstall Service as advised by FuelMaster Customer 
Satisfaction Center. The Options on this dialog do not apply to the Download Service. 
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To see the current status of all Download Services, click View > List Download Services. 
This displays information about the Download Services. For more information, see 
MultiPoint Download Service. 

 

Polling Reports 

When a manual download occurs, FMPlus displays a Polling Report showing the results of 
the online session. To set the options for the Polling Report, select System > Polling Report 
Configuration.  
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The Polling Report can be set to auto print or be auto-saved in a variety of file types. When 
the Polling Report is setup not to display on screen, it is still available from Operations > 
Polling Report Query.   

 

The Polling Report is comprised of a series of smaller reports that can be turned on or off 
based on user privileges. The Polling Report Configuration has two sub-report areas: normal 
and messages.  

Pump Prices Report 

This report is used to ensure that the prices stored and used in the FMU are the same as the 
current prices set in the software. This makes it an excellent tool to detect incorrect 
transactions. 

NOTE This only works for the last download. 

Message Reports 

Message Reports are used to display events that occur at the FMU.  One of the most useful 
Message Reports is the PM Warning Report which shows when a Vehicle has passed its 
mileage for Preventative Maintenance.   

Polling Reports for Auto Downloads 

To generate Polling Reports for Auto Download sessions, open Config > DL Service, and 
check the box to Display autodownloaded polling report on this computer. 
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The Polling Report Configuration must also be set to Show on Screen in the Polling Report 
Configuration. 
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Chapter 11 FuelMaster Reports 

FMPlus has the capability to provide a large amount of information on the status and 
activity of FMU units at the fuel island. It also brings back a large amount of data 
pertinent to the maintenance and status of vehicles fueling. This information is stored in 
the database and is made available using the FMPlus reports package.  These reports 
are generated using a Crystal Reports engine and have many different sorting and 
grouping abilities. 

To enable and run Crystal Reports in FMPlus, an ODBC Data Source Name (DSN) must 
be configured to connect to the FMPlus database and be set in System > Database 
Manager. For detailed information, see ODBC Connections for Reports. 

Report Configuration 
FMPlus’ standard report package is supplemented by the ability to do custom reports 
for our customers.  If you have a custom report, or are advised someone else’s custom 
report will work for you, configure it using the report configuration option. 

From the System menu select Report Configuration. 

 

From the Report Configuration interface, select the Report Type, the report it is based 
on, and the custom report that meets your needs.  If you need advice or assistance, 
please call CSC at 1-800-888-9136 ext. 2.  
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FMPlus Standard Reports 
FMPlus has a wide variety of standard reports. A general overview is provided for each 
report type.  

Standard reports can be accessed using the Reports menu. 

 

FMU Activity Report 

The FMU Activity report displays a month to date and year to date summary of fuel 
transactions of each hose per site. It also displays a summary of Tank adjustments for 
the site.  
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Transaction Reports 

Each transaction report category may have sub-categories. Reports can run from any 
of the sub-categories.  

These reports can help you find transactions to review. For example, the Credit Card 
Type Report can help locate a Credit Card transaction via the brand of the card, i.e. 
Visa, MasterCard, WEX, etc.  

 

Invoice Reports 

Invoice customers for fuel they receive.  

The report can display individual transaction details as well as total number of 
transactions, total quantity, and total cost in a specified date and time range.  
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Site Reports 

Displays information regarding the site location and inventory status of the tanks. 
Inventory and Delivery reports provide a variety of options for inventory management 
data retrieval.  For example, the Inventory Report displays current tank inventory at the 
specified site, such as Last Delivery and Last Stick Reading. 

 

Vehicle Reports 

Displays the status and general information for all vehicle records stored in the 
database. This includes all data stored on Prokee/Smart Cards for each vehicle. 

For example, the Efficiency Report shows gallons fueled and odometer readings to give 
approximate MPG readings. AIM Status and History Reports show the current state of 
AIM records, historical programming, installing, updating, and other non-transaction 
data.         
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Vehicle Odometer Report 

The Vehicle Odometer Report is only available if the Dash Odometer customization has 
been implemented. See Appendix D Dash Odometer for AIM2.4 & AIM Titanium. 

User Reports 

Displays information on the selected Users, including whether the record key has been 
encoded, authorized, or unauthorized.  

 

Customer Reports 

Displays Customer information, Point of Contact, the Vehicles and Users assigned to 
the Customer.  
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Utility Key Reports 

Generates a listing of the Supervisor, Tanker Truck and Manual Issue keys.  The 
description, Customer ID, Key Type, etc. identify the key and options.  

 

Prepaid Cards 

If you have purchased this option these reports provide Unclaimed Credits listing the 
Prepaid keys, Owner ID, Amount of outstanding Credit, and the Balance on the Card. 
Card History displays all card information, such as date the record was created, date 
card was encoded, and any credits or deductions. 
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OBD Data (AIM Only) 

Generates vehicle information gathered from the on-board computer from active AIMs.  

 

Preventative Maintenance 

Retrieves a list of vehicles that are either overdue or over notice based on the current 
odometer reading of the vehicle.  
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Chapter 12 Exporting Options 

FuelMaster offers the ability to export data from FMPlus to a file that can be imported 
into other software. The format and data contained in the export differs depending on 
your needs. The standard set of exports are requested by customers on a regular basis 
and may meet your needs. 

FuelMaster can customize an export if you need something to change or new data to 
be added. To request a customization, contact your salesperson. 

Export Configuration 
Select Export Configuration from the System Menu. 

Exports in FMPlus are flat ASCII text files with varying field orders, delimiters, and data 
sets. There are common exports used by our customers provided free of charge with 
FMPlus. The format of these exports can be obtained via CSC, 1-800-888-9136 ext. 2.  If 
none of these formats meet your needs, contact your salesperson about a custom 
export order. 
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Export Configuration Tool 

Select the export type; then specify the location and name of the export file to 
generate. The location and file name can be left as the default or changed. 

The Auto Export option generates an export immediately upon download completion. 

For exports using transaction counters, specify the counter minimums and maximums. 

 

Transaction Export 

To export transactions manually, select Transaction Export under the Operations 
menu.  
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Transaction Export Interface 

The Export Interface allows you to view and manage transactions that will be written to 
the export file. The list shows transactions that meet the criteria selected from the 
Show options. Exportable transactions are those that will be written to the file. Detain 
transactions to review for possible later export and not include in the file. Delete to 
mark transactions deleted and to discard after the export is complete.  

 

 

A report is generated at the time of export to provide a summary of the export.  

This report can be configured, and the list can be viewed. When all options have been 
configured, click Export to write the file.  

 

Filter by Transaction Code (TC) in Export View  

If the transaction code (TC) is being exported, users can filter records by TC as well as 
by Exportable, Detain, Delete, and All.  Clicking on the radio button causes the view to 
display only transactions with the TC chosen in the combo box. These controls are 
hidden if TC is not part of the export definition. 
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Chapter 13 Administration 

FMPlus security features allow the administrator to control who has access to what 
parts of the software and how that access is managed. FMPlus has data and operations 
that are sensitive in nature. Security options allow or restrict access to a wide range of 
program functions. In addition, the Security Configuration feature lets you define 
security record requirements and management settings, like expiration dates, number 
of incorrect login attempts allowed, etc. 

 

Security Configuration 
The Security Configuration for FMPlus can be accessed via the System menu.  

 

These settings can be made to be as secure or as open as each customer’s 
circumstances require. Understand, however, that tight security can be both a benefit 
and, in some cases, an inconvenience.  Choose a reasonable security configuration for 
your installation and the users of the software. 
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Security Settings Tab 

 

 

Login Name  

Establishes the minimum length of the Login Name. 

Exclude Words 

Sets words that cannot be used for passwords such as company name, location or 
admin. 

Exclude Substring  

Restricts the use of substrings from passwords such as 12345. 

Restrict Password Reverse 

Keeps users from establishing a new password by reversing their current password. 

Restricted Password Shift Characters 

Number of characters the password must differ by each time the password changes. 

Password Fail Lockout 

Number of times you can enter the password incorrectly before the login is locked out 
until an administrator unlocks the user login. 

Minimum Length 

Setting that declares the minimum length of the password. 

Minimum Numeric Character 

Password requires at least this many numeric characters. 

Minimum Alpha Character 

Password requires at least this many alpha characters. 
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Minimum Special Character 

Password requires at least this many special characters. Examples: [ !@#$%^ ]          
special characters that may not be used in passwords include: < > “ : and ; 

Characters New Password Differs from Old Password 

Distinguishes how many characters must be different from the old password. 

Days Until Password Expires 

A password change can be set to prompt the user. They will need to establish a new 
password before the days expire. 

Expiration Warning Days 

Warns a user they need to change their password before it expires. 

Passwords until able to Repeat 

Number of stored historical passwords that rotate until a previous password can be 
reused. 

Days until Password able to Repeat 

Limits number of days before a password can be repeated. 

Log Events 

Set the events that will be recorded in the database as an audit trail for security 
operations, changes, errors, etc.  

Select the log events you desire using the Events check boxes. Click Save. 
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Operator Options 

Individuals who are allowed access into FMPlus enter a username and password. 
Operators can be assigned specific permissions for software operations using the List 
Maintenance menu, which raises the Operator List dialog box. 
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Operator List 

Displays current operators with access to the software. The ADMIN operator is set by 
FMPlus. Add an operator by entering the name in the Operator field and clicking New. 
Enter information about the Operator.  

  

The Login column refers to the operator name used to login to FMPlus. Once an 
operator name has been established, a dialog displays with a series of tabs to authorize 
access to specific parts of the program for each operator.  

To create an admin with all privileges, or to remove all privileges from an existing 
operator, use the Select All or Deselect All buttons on the bottom of the interface. 
Most tabs contain checkboxes for ‘Add’, ‘Edit’, and ‘Delete’. These control whether an 
operator can create, modify, or delete the type of record for that field. For example, an 
operator with only ‘Edit’ permissions on the Vehicle Tab could not create or delete a 
vehicle record, but could open and modify a vehicle record. 

General Tab 

Identifies basic operator login information.  

 

The ‘Authorized’ checkbox controls the access of the operator login. A date/time 
denotes when the operator was authorized or unauthorized.   
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The ‘Locked’ check box is used when an operator has entered his/her login sequence 
incorrectly too many times.  An operator with sufficient privileges can use this 
checkbox to re-enable the operator login by removing the check from the box. 

Operator & Security Tab 

These permissions control who has access to setup other operators and change their 
operator permissions. 

 

Security Configuration controls the menu option Security Configuration (first section 
in this chapter). 
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System & Operations Tab 

These permissions control the creation, editing, and deleting of system configurations, 
products, and customizations. The list of functions in the lower left provide additional 
flexibility.    

 

The Online permissions authorize operators to perform functions that require 
interaction with the FMU. For example, you may authorize an operator to download 
transactions from a site, but might not want them to send pricing or price sensitive lists. 

Site Tab 

Contains permissions pertaining to the creation of Sites and their sub-elements, Tanks 
and Units.  
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Transactions Tab 

Includes permissions for control of archiving, exporting, modifying, recovering, and 
updating transactions records. 

Also controls permissions for Manual Entry and Database Maintenance.  

     

Supervisor and Manual Issue Tab 

Sets permissions for the Supervisor and Manual Issue key records.  
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Vehicle and User Tabs 

The Vehicle and User permissions authorize operators to create, modify, or delete 
Vehicle/User records. You can also set permissions for the operator to encode, reissue 
and authorize or de-authorize the Prokee/Smart Cards or AIMs.  

  

Tanker Truck Tab 

Authorize operators to manage Tanker Truck records and Prokee/Smart Cards. 
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AIM Tab 

Set permissions to manage the AIM Programmer section including Prokee/Smart Cards. 
AIM Installation controls installing AIM modules in Vehicle records. Also controls the 
ability to send and receive the AIM Programming List to the FMU(s). 

 

Card Owners Tab 

If you have purchased the Local Authorization or Discount and Prepaid Card features, 
you may set permissions for Card Owners, Discount CC, Prepaid, and Local 
Authorization. For Prepaid keys you can also restrict the ability for the operator to 
encode a Prokee /Smart Card. 
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Service Configuration Tab 

Provides the ability to authorize interaction with various Services through the Service 
Configuration tab. The FM Download Service requires the Download permission. 

 

ADOC Tab 

Set permissions to Add, Delete, and Edit Agency, Department, Organization, and 
Customer data.  

 

 

 

 



FMPlus User Manual 
Document Version: 5.0 

Chapter 13 Administration 
 

12/05/2022 © Syntech Systems, Inc. 2014–2022. 120 

New Operator Login  

New operators can be selected from the Operator Name dropdown list.   

 

A password is not entered for a first-time login. Prompts guide the operator to set the 
password, which is then used to login.  
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Chapter 14 FuelMaster Tools 

FMPlus includes a set of tools to assist in managing your database and handling 
abnormal situations. There are options for manual entry of transactions and inventory 
data, database backup and recovery options, transaction importing, and exported 
transaction recovery.  These tools are provided to help fix any issues that may occur, 
but FuelMaster also provides easy access to the CSC, where a technician can help 
quickly resolve any issue you encounter. 

FMU Console 
The FMU Console allows the Central Controller to communicate directly with the 
FMU to perform a limited series of diagnostic and configuration commands. The 
console communicates with the FMU in the same manner as the other online FMU 
functions (via network or phone line). 

To access this feature, use the Console icon found on the FMPlus Toolbar. 

 

NOTE The Download Service does not have to be stopped prior to running the 
FMU Console Interface. However, there should be no active upload or 
download sessions while logged on to the Console. 

This feature can shut down or re-enable a specific hose position, authorize a 
transaction, or configure the header and footer for your receipts.  

From the FMU Console, select the Site ID or the Site Name from the dropdown 
boxes and click Dial (even if you are using a network interface). 

Once you have connected to the FMU, a menu appears in the main part of the FMU 
console interface. Each option provided is accessed by entering the number of the 
commands and pressing ‘Enter’. 
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You can view the commands shown below and send commands via pass-through to 
a Satellite. 

 

Polling Report Query 
Check on the results of any historical download process by regenerating the Polling 
Report. This tool is accessed through the Operations menu. 
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Polling Report Query Engine 

Use the engine to select the criteria for the polling report you would like regenerated. 
Select 7 Days or 30 Days to narrow your search.  

 

Batch Encoding 
Encodes many keys in one sitting without having to open each Vehicle record 
individually. 

 

For example, if importing Vehicle or User data from another spreadsheet or database 
to FMPlus, use Batch Encoding to create the large number of keys. 

Access the Batch Encoding Tool from Batch Encoding under the Operations menu. 
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Batch Encoding Tool 

Includes four sections: Prokee/Smart Card Type, Vehicle or User Grouping, Records 
List, and Encode Status Information. 

 

Select the type of keys to create and the groupings to encode. The list of records 
that match your criteria displays in the list. 

Once the matching records display, select the individual records by checking the box 
next to the desired record. As records are encoded, the status information changes. 
When Encode has been clicked, you have 30 seconds to insert the Prokee/Smart 
Card.  Once the first key has encoded successfully, the encode process will 
automatically start again after you click OK to confirm the encoding of the previous 
key. 

Manual Entry Transactions 
Transactions run in Manual Mode due to dispenser, FuelMaster issues, or possibly 
emergency situations, can be entered in FMPlus. 

 



FMPlus User Manual 
Document Version: 5.0 

Chapter 14 FuelMaster Tools 
 

12/05/2022 © Syntech Systems, Inc. 2014–2022. 125 

Manual Entry transactions contain the same information as a transaction recorded by 
the FMU. However, this option cannot be used for Credit Card transactions. 

Access this option via Manual Entry Transaction from the Operations menu. 

Manual Entry Transaction List 

Manage transactions that have not been recorded by an FMU. 

 

Click To MainDB to move the entered transactions into the database. Once 
completed, the transactions can be exported and viewed in reports. Manual Entry 
transactions are only used for Sale transactions. 

Manual Entry  

The interface contains all the fields required for a manual entry transaction. It is 
important to understand that the OK button saves the transaction in a temporary 
location.  

To move it to the database, you must use Save to MainDB or To MainDB from the 
Transactions List. 
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Trans. ID 

A unique number that identifies this transaction while in temporary storage. 

Trans. Code 

Defines the type of transaction. 

Vehicle ID 

Select an existing record in the Vehicle List from a dropdown list. 

Vehicle Desc. and Agency 

Populated from the selected vehicle record. 

Odometer 

Current odometer reading of the vehicle that was fueled. 

User ID 

Can be selected to identify the user who fueled the vehicle. 

Site Information 

Used to identify site, hose, product and tank from which the fuel was dispensed. 

Customer ID 

Can be selected to identify the customer. 

Update Inventory 

Check to set this transaction as one to be deducted from the tank's inventory. This 
feature must be used with caution when using TMUs since it can lead to multiple 
deductions of the same fuel. 

Quantity 

Amount of fuel dispensed in the transaction. 

Unit Cost 

This field is automatically filled when the site and hose fields are selected.  It can be 
changed if the price has changed since the transaction has taken place.  

Total Cost 

Calculation is generated automatically based on the Quantity and Unit Cost. 

Trans Date & Date 

Date/Time the transaction occurred. 
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Inventory Editor 
Allows for the entry and correction of Adjustments, Deliveries, and other tank 
inventory data. This is useful for entry of inventory records that occurred in the past 
where other inventory transactions have occurred since. This ability is key to the 
proper operation of the Fuel Costing and History Ledger reports. 

 

The Inventory Editor is accessed via the Operations menu. This feature is explained 
in detail in the Tank Configuration section of Chapter 5. 

Inventory Editor Interface 

Select the Site and Tank to edit. 

To add a delivery or adjustment, refer to Chapter 5, Inventory Editor Section. 

 

Archive Records 
Customers with large quantities of transactions can improve the performance of 
FMPlus by archiving historical transaction information. Archived records are written 
to a backup database and are no longer available for reports or exporting.  
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Only archive records no longer needed for reporting or accounting. FuelMaster 
recommends records be archived on a yearly basis. 

 

Archive Records Tool 

Select the table of transactions to be archived out of the main database from the 
dropdown menu.  

Using the options below, select criteria to archive by selecting Archive All, Download 
Time, or Date and then Archive. 
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Restore Records 
Records may be restored to the main database from an archive database using the 
Restore Records Tool. 

 

Restore Records Tool 

Select the table of records to be restored to the main database from the dropdown 
menu.  

Using the options below, select criteria to restore by selecting Restore All, Download 
Time, or Date and then Restore. 
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Archive Transactions History Query 
Shows the status of previous transaction archiving activities. Access Archive 
Transaction History Query from the Operations Menu. 

 

Archive Transaction Query Engine 

Select the Operation Type and choose All History or Last # Operations, or use 
Select History Period to specify a range.  After clicking View, the history information 
appears in the Archive/Restore Transaction History window.  
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Adjust Price Level for Transactions 
Pricing on a particular transaction can change if, for example, an operator forgets to 
update the pricing when a delivery has been received or there is an incorrect price 
level.  

Access Adjust Price Level for Transactions from the Operations Menu. 

 

Adjust Transaction Price 

Select the Transaction Code from the dropdown box. Set the date range of the 
transaction. Choose Tank or Product for Transaction Type. Click View Selected 
Transaction. Highlight the desired transactions and click Modify.  
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Command Line Setup & Helper 
One of the FMPlus legacy systems was a DOS-based application that had the ability 
to open FMPlus and perform program operations via scripting in DOS. This option 
allows customers who had that system maintain their historical operational structure.  

Access Command Line Setup & Helper from the System menu. 

 

 

Command Line Setup Options 

Command Line Setup & Helper offers options you can use in Windows Task 
Scheduler. Options in the Command Line Helper configure the operations that the 
command line will execute.  

Auto Logon with Password is used to logon with a specific operator name and 
password. 



FMPlus User Manual 
Document Version: 5.0 

Chapter 14 FuelMaster Tools 
 

12/05/2022 © Syntech Systems, Inc. 2014–2022. 133 

Auto Go Online automatically downloads the FMU based on the options configured 
and saved in the software. 

Database Manager 
FMPlus uses Microsoft SQL Server to store all transaction and configuration data. A 
database can be located on the local PC, a shared PC, or on a server. FMPlus can be 
configured to point to one database from multiple PCs. 

MS Access is only supported for the purpose of conversion to MS SQL Server. 

Access Database Manager from the System menu.   

 

Database Manager Interface 

Contains a list of configured databases, their database type, and database path. The 
flag icon denotes the current database. 
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Creating a new or editing an existing database will expand the current window to 
show the database configuration options.  For instructions on creating, editing, and 
adding a database, see the FuelMaster Installation Guide. 

 

Browse allows you to select from all available SQL Servers and databases. 
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Reset Download Path 
The Download Path is typically set up when the database is initially configured. But it 
can be changed from this menu or from System > Configuration > DL Service. Stop 
the Download Service(s) before changing the Download Path. 

 

The Download Path should be a shared network location accessible to all Download 
Services. 

System Diagnostics 
The System Diagnostics utility detects whether your network is properly configured  
for Syntech’s products.   

 

Among the items checked are servers, IP addresses, UNC paths, and necessary ports. 
If desired, running the utility and sharing the results with CSC may help to 
troubleshoot certain issues.  
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Chapter 15 Database Utilities 

FMPlus provides a set of tools to help manage your database size, performance, 
record sets, and backups. These tools are collectively known as Database Utilities 
and cover a large range of operations and needs. The goal is to make sure the 
software performs at the best possible level, while at the same time protecting 
current and historical data loss or corruption. 

Database Maintenance 
Access Database Maintenance from the System > Database Utilities menu. 

 

The following actions can only be performed on the database the software is 
currently pointed to in Database Manager. The process box at the bottom of each 
dialog displays current progress and messages. 
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Delete Records 

Some database records have a limited shelf life. For example, a message transaction 
from two years ago may not be much use today. Some databases may have 
performance issues due to large amounts of data. 

Once records are deleted, they cannot be recovered. Deleting is not recommended 
without consultation with CSC. Complete record deletion before shrinking the 
database. 
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Shrink Database 

After deleting records, database performance may be improved by shrinking the 
database and rebuilding indexes. Verify the database to shrink and re-index shows in 
the Current Database Information box. Select the checkbox and click Go. 
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Backup and Restore 

Verify the database to be backed up or restored shows in the Current Database 
Information box. Select the radio button for the appropriate option and enter a 
backup file name. Including the type (full, differential) and date in the backup file 
name helps select the correct file for restore. Click Go. 
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Backup and Restore Archive 

Complete the form to restore the archive database. See Backup and Restore fore 
more information. 

 

 

Customers with large databases should consider scheduling Shrink Database and 
Backup maintenance quarterly. 
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Recover Transactions 
When transactions are downloaded from the FMU, they are copied into a transaction 
file before being written to the database. If transactions cannot be found in the 
database, they can be recovered from these transaction files.  

Access Recover Transactions from the Database Utilities menu. 
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Recover Transaction  

Recover Transaction from Temp File is used to select the file and display the status. 
Check Include Inventory Operations to include inventory updates. 

 

The Temp files are stored in a subfolder in the FMPlus download path directory. 
Select files using the Browse button.  

Once you have selected the appropriate files, click Open to begin. The status window 
will display the progress of the operation and any problems encountered. 

 

TMP filenames include date/time, so you can choose files based on the timeframe 
desired. This will recover all transactions from a given online session, so if you are 
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only missing one transaction out of a download, you may get duplicates. Duplicates 
can be cleaned up using several of the tools discussed in the previous chapter.  

Transaction Lookup 
Transaction Lookup allows you to search for specific manual entry transaction data 
that you think is missing.  

Access Transaction Lookup from the Database Utilities sub menu. 

 

Transaction Lookup Tool 

Transactions can be searched by a variety of criteria: Trans Code type, Transaction 
Period, last X number of transactions, all transactions, or duplicates only. For 
duplicates, you can check the High Threshold box to make requirements more easily 
met.  
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Click View Selected Transactions to populate the list box with records matching the 
search criteria. 

 

Transactions in the list box can be selected and deleted using Select All and Delete. 

Modify Transactions 
Sometimes transaction records can contain incorrect data. The feature is accessed 
using the Modify Transactions option under the Database Utilities sub menu. 

 

NOTE You can only modify Fleet Only transactions. Credit Card or Prepaid records 
are final once they run at the FMU, and cannot be modified using FMPlus. 

Modify Transaction Engine 

To modify a transaction, define the selection criteria using the Modify Transaction 
Engine. Once the list is populated with matching transactions, click Modify to open 
the record for editing. 
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Be very careful using this feature. 
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Modify Transaction 

Once a transaction has been chosen for modification, it can be edited using the 
modification tool.  

Record Status shows whether it has been modified or not.  The Modify Critical 
Fields and Add/Update to Export Table checkboxes control what can be changed 
and where to save the changes when done. 

 

Certain fields are not normally allowed to be modified for inventory maintenance 
reasons. If you decide you would like to edit these fields then you will need to check 
the Modify Critical Fields checkbox. However, when modifying these extra fields, the 
inventory will not be updated. This allows editing all the information of the 
transaction such as the Date/Time, Site ID, and Hose.   
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Recover Export Transactions 
If transactions are misplaced between export from FMPlus and import to another 
program, you can recover them from the main transaction table. This re-populates 
the export table from the main transaction table. The transactions can then be 
manually exported as discussed in Chapter 12.  

 

Access Recover Export Transaction from the Database Utilities sub menu. 

Recover Export Transactions Engine 
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Recover Export Transactions identifies the transactions to be recovered by 
selecting one option: 

• Online Time Click the radio button and select an online time by double- 
clicking the date and time. 

• Range for Online Time Click the radio button and set the beginning and 
ending dates. 

• Range for Transaction Time Click the radio button and set the beginning 
and ending dates. 

• All Transactions Click the radio button. 

Click Recover to perform the recovery. 
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Appendix A ODBC Connections for Reports 

Overview 
Due to Microsoft’s depreciation of older security protocols, including those used in 
database drivers to connect Crystal Reports to SQL Server, the reports now use 
ODBC connectivity. This allows the Crystal Reports used in FuelMaster Plus (FMPlus) 
to utilize a driver that supports Transport Layer Security (TLS) 1.2, the currently 
shipping version, and future iterations. 

To run the Crystal Reports provided with FMPlus, an ODBC Data Source Name (DSN) 
configured to connect to the FMPlus database must be created on each machine 
running FMPlus. The DSN must also be set correctly for each corresponding entry in 
FMPlus > System > Database Manager. 

Compatibility 
This change occurs in SW 5.15.3.0 and greater. It is required for all client platforms. 

Configuration 

Creating an ODBC DSN for FMPlus on a SQL Server 

After installing or upgrading to FMPlus v5.15.3.0, or greater, create an ODBC DSN 
using the ODBC Data Source Administrator utility. To locate, type “ODBC” in the 
operating system search field: 

 

Select the Data Sources (ODBC) program, and Run as administrator.  
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Click Add… 

 

On the Create New Data Source dialog, select SQL Server Native Client 11.0.  

Click Finish.  
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On the Create a New Data Source to SQL Server dialog, enter the name for your 
ODBC DSN, enter Description if desired, and specify the SQL Server by machine 
name\SQL instance: 

 

NOTE The ODBC DSN can be any name, but if there are multiple databases on a 
machine, it may be helpful to give the ODBC DSN the same name as the 
database. 

Use the ODBC Microsoft SQL Server Setup to test the new connection by clicking 
Test Data Source…. 

  

If the tests fail, check your SQL server machine and instance names. Correct as 
needed, and retry connection. 
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Setting the ODBC DSN in FMPlus 

Before launching Database Manager, if running, stop the Download Service. 

 

Launch Database Manager via System > Database Manager. Select the database, 
and click Edit>>. On the Edit dialog, enter the ODBC DSN. The dialog Successfully 
Edited a FuelMaster Plus Entry! appears when the edits are saved. 

Restart the FMPlus client. Reports may now be run successfully. 
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Creating an ODBC DSN for FMPlus Remote from SQL Server 

When the Client is on a machine remote from the SQL server, there are several 
additional steps in the ODBC Data Source utility. 

The following steps for creating an ODBC data source are the same as above: 

• Launch ODBC Data Source Administrator > Click Add… 
• Select SQL Server Native Client 11.0 > Click Finish 
• Enter the Data Source Name and Server > Click Next 

Additional steps: 

Select the authentication type to verify authenticity of the login ID: 

 

If using Windows Authentication, the computers must be in the same NT domain. 

If using SQL Server authentication, enter the same Login ID and Password as 
specified in Database Manager for the database. 
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In the dropdown for Change the default database to, select your database name. 
Leave other options as defaulted. 

 

Click Next. 

Accept the defaults on the next screen, and click Finish. 
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At this point, the additional steps are complete, and the ODBC Microsoft SQL Server 
Setup dialog presents the summary with the Test Data Source button. 

  

If the tests fail, check your SQL server machine and instance names. Correct as 
needed and retry connection. 

Resume with the steps above to set the ODBC DNS in Database Manager: 

• If running, stop the Download Service 
• Launch System > Database Manager 
• Highlight the database > click Edit>> 
• Enter the ODBC DSN > click Save Edit<< > click OK on success dialog 
• Restart FMPlus > Run Reports 

Additional information 
Several checks and reminder messages have been provided. 

If you launch FMPlus after installing or upgrading but before adding the ODBC DSN 
to Database Manager, this dialog displays: 
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Clicking Yes will launch Database Manager. The ODBC DSN must be created in the 
ODBC Data Source Administrator before the Reports will work. 

Clicking No will allow normal client functions except for running Reports. This 
message will appear each time you launch FMPlus until the ODBC DSN is set. 

This dialog is displayed if the ODBC DSN has not been set and you attempt to launch 
a Report: 
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Appendix B Communication Timeouts 

Overview 
FMPlus supports configuration of communication timeouts. This feature was added 
to support Satellite Cellular Modems, most often used with Passive Mobile Units, but 
impacts all communication timeouts. The software has default timeouts for 
communication between the SW and the FMU that typically range from 2 to 4 
seconds. These default timeouts may be extended up to 6 seconds using the 
Configuration > System > Add Comm Timeouts feature. 

Compatibility 
Communication Timeout configuration requires FuelMaster Plus SW 5.11.3.2 or 
greater. For best performance and reliability, FMU FW 3.85a or greater is 
recommended. 

Configuration 

Communication Timeout Configuration 

Access the Timeout Configuration via: 

• Menus – System > Configuration > System tab, or 
• Config Icon – Config > System 

 

A value of “0” indicates that the SW default timings are sufficient, and no additional 
timeout extension is needed.  
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Values from “1” to “6” extend the communication timeout up to the specified number 
of seconds. A timeout extension of 2 or greater is recommended for Satellite Cellular 
Modem communications. 

The communication timeout value is applied by clicking OK. 
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Appendix C SW Configuration of AIM 
Options 

Overview 
All AIM Options are configured through the software instead of on individual AIMs.  

AIM Options 

 

Require User 
ID 

When the Enable user ID option is active on the FMU, and 
Require User ID is enabled on the AIM, user must enter a 
user ID at the FMU (either at the keypad or with a user 
Prokee) before a transaction can start. 

Fuel with 
Engine On 

When set, AIM can detect that a fueling tag or 
programming hose tag (PHT) is inserted when the engine is 
running. 

Use Metric 
Units 

When set, the odometer value is sent to the Central 
Controller in kilometers. 

Enable Analog 
Counter 

When set, counts the low to high transitions on Analog 
Channel 1. 

Enable FOSS  Force OBD Sleep Silence. When set, the AIM does not send 
any OBD requests to the vehicle when the AIM is asleep.  

Disable SVT  Switch Vehicle Test. When ticked, the switch vehicle test 
will not be performed.  

NOTE This feature is only supported in AIM2.4s. For more 
information see Addendum DEV01166_ 
DEV01169_Switch Vehicle.PDF. 

 

Disable 
Timeouts  

When set, sleep timeouts are disabled. The AIM never goes 
to sleep. 

Enable FOIOS  Force OBD Ignition Off Silence. When set, this prevents the 
AIM from sending any OBD requests to the vehicle when 
the wakeup wire input is low.  
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Enable GCM  Gateway Compatibility Mode. Set to enable compatibility 
with certain Intermotive third party devices. This option 
cannot be defaulted and is only available via Vehicle 
Record. GCM must be set up and configured by Syntech 
Systems, Inc.’s CSC.  

Configuration 
In the software, the AIM Options configurations may be set in two places: 

Configuration > AIM > AIM Options Defaults. Settings in Configuration are 
applied when new Vehicle records are created with the option automatically 
selected on the Vehicle > AIM tab. This Configuration setting does not affect any 
existing vehicles. 
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Vehicle List > Vehicle > AIM > Options. The settings in the Vehicle record are sent 
via the AIM Programming List to the FMU. When changed in the Vehicle Record, 
after the AIM Programming List is resent, Vehicles enumerating at the FMU have 
updates to the configuration applied through auto record update.  

 

Additional information 

Changes to the AIM’s Advanced Options (AOPT) Command 

AOPT options are: Force OBD Sleep Silence (FOSS) and Gateway Compatibility 
Mode (GCM). The Allow Firmware Update AOPT option is now permanently 
enabled and always allows firmware update even if it was disabled in a previous 
version. 

AOPT command options are now software-configurable only. 

Any options set in AOPT prior to AIM2.4 v2.19 and AIM Titanium v3.21 can no 
longer be disabled through the AOPT command, but the AIM can be cleaned to 
clear these. 

The AIM will grandfather in any already-enabled AOPT options. For example, if 
GCM is enabled on a v2.10 AIM2.4 and is then updated to v2.19, the GCM 
functionality will be preserved because even though it's not enabled in the 
software, it's still enabled in the AOPT command. Since GCM cannot be disabled in 
AOPT, the AIM must be cleaned to clear the option.  
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Appendix D Dash Odometer for AIM2.4® & 
AIM Titanium™ 

SW v5.19.3.0 / FMU FW v4.04 / AIM2.4 FW v2.18 & AIM Titanium FW v3.19 

Overview 
Dash Odometer support began in AIM2.4 FW v2.13 & AIM Titanium FW v3.16, with 
FMU FW v3.93 and FuelMaster Plus SW v5.9.3.0 for light duty CAN vehicles. This 
premium feature detects and automatically captures Dash Odometer for 
supported Ford, Chrysler, and GM vehicles in model years 2008 to 2016.  

Data Set updates provided with FMU FW v3.98 and FuelMaster Plus SW v5.13.3.0, 
add supported vehicles for model year 2017. Some 2018 vehicles will be supported 
using model year 2017 data. Future Data Sets will be provided to add newly 
supported vehicles and as needed for new model years. 

FMU FW v4.04 adds the ability to automatically apply new Data Sets without 
having to manually retry at the FMU front panel.  

When a vehicle is not supported, standard steps for Derived Odometer calibration 
must still be implemented. The Supervisor has the ability on a vehicle by vehicle 
basis at the FMU to: 

• Reject the Dash Odometer captured and manually calibrate the Derived 
Odometer or  

• Retry the Dash Odometer detection on a vehicle that is using Derived 
Odometer.  

The FuelMaster Plus SW shows the Dash Odometer status and odometer method 
in the Vehicle record and generates reports on the odometer information. 

Compatibility 
Dash Odometer requires a minimum of AIM2.4 FW v2.13 or AIM Titanium FW v3.16 
with FMU FW v3.93 or greater and FuelMaster Plus SW v5.9.3.0 or greater.  

Application of updated Data Set files requires FMU FW v3.98 or greater and 
FuelMaster Plus SW v5.13.3.0 or greater. 

Automatic retry to apply new Data Sets requires FMU FW v4.04 or greater. 
Recommended SW version for FMU FW v4.04 is SW v5.19.3.0. 
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Configuration 

Installation 

Install the software on all Central Controllers. Customers request the Dash 
Odometer license key and Dash Odometer Data Set files from Syntech Systems, 
Inc., before updating FMUs. The license is generated with KeyGen 5.9.0.3 or 
greater.  

Upon receipt of the Dash Odometer license, copy the license to a location 
accessible from FuelMaster Plus, such as the \\Program Files 
(x86)\Syntech\FuelMasterPlus directory.  

Copy the Dash Odometer files to a location accessible from FuelMaster Plus. You 
will be asked to browse to the data set file location when the license is applied in 
System > Customizations in FMPlus or when data set updates are applied via 
Operations > Update Dash Odometer Data Sets. 

 

Dash Odometer Set Up 

The FMU uses the Vehicle VIN to determine whether the Vehicle supports Dash 
Odometer. If the VIN indicates Dash Odometer is supported, the vehicle’s dash 
odometer capture is attempted. At any time, from the FMU front panel, the 
Supervisor can reject Dash Odometer and use Derived Odometer. Odometer 
information is passed through the AIM to the FMU which passes the information to 
the SW.  

If the Dash Odometer capture is unsuccessful, the Vehicle uses Derived Odometer 
and requires manual calibration. If Dash Odometer is supported for this vehicle in 
the future, using the Supervisor Key at the FMU front panel, the Dash Odometer 
detection can be run again.  

After FMUs are updated, update AIM2.4s and AIM Titaniums. Automatic FW 
Updates are supported. 
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Software Support for Dash Odometer 
The FuelMaster Plus SW manages the Data Sets for Dash Odometer, tracking when 
to send or update them to the FMUs. The Vehicle Record > Odometer tab displays 
the Dash Odometer status and odometer method. The SW also supports 
generating reports to show vehicle odometer Information. 

Data Set File Management 
The Data Set files provide information to determine if the VIN is supported for 
Dash Odometer and are provided to the customer with the Dash Odometer license 
and when Data Set updates occur.  

 

Initial Implementation 

On initial implementation, when the license is added in System > Customizations, 
the Data Set files may be sent automatically to each FMU in the system. Click Add 
File…, browse to the location where the Dash Odometer Data Set files were saved, 
and click Select Folder.  

 

NOTE Always browse to the location where the Data Set files were saved by the 
customer, even if the “dataset” folder in the download path already exists. 
Pointing to the “dataset” folder in the download path results in an error 
and does not provide the ability to automatically send the Dash Odometer 
data set files to the FMUs. 

A dialog opens to select the location of the Dash Odometer Data Set files. 

If the selected location does not contain the files, a dialog allows a second try. 
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When the Dash Odometer Data Set files are found, SW copies them to the 
Download Path in a folder named “datasets”. The next dialog offers to go online 
and update all FMUs. 

 

 

If Yes is selected, an Online session is initiated and the three Dash Odometer Data 
Set files are transferred to each FMU and placed on the compact flash card in the 
“aim_dash_odom” folder. 

If No is selected, focus returns to the Customizations dialog and shows the Dash 
Odometer license. Site Configuration updates and Online sessions verify the Dash 
Odometer Data Set files existence and version and, when necessary, transfer 
appropriate Dash Odometer Data Set files to the FMUs.  

The SW verifies the Dash Odometer Data Set files exist and are the correct 
version: 

• When a Site Configuration is uploaded 
• When a Manual Download is initiated and 
• When an Auto Download is run. 

Polling Report Summary Site details and Status Logs indicate when Dash 
Odometer Data Set files are current or have been uploaded successfully and 
verified. 

When Dash Odometer Data Set files exist on the FMU, but Dash Odometer 
customization is not enabled for the database, SW removes the Data Set files from 
the FMU. 
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Data Set Updates 

When updated data sets are provided, copy the files to a location accessible from 
FuelMaster Plus; for example, the PC’s Documents folder.  

To access Operations > Update Dash Odometer Data Sets, the Dash Odometer 
customization must be enabled, and the operator must have the permission for 
“Send/Receive Programming and Update List” under System > Operator Options > 
List Management > [User] > AIM. 

When selected, the Dash Odometer Data Sets dialog displays showing the three 
Data Set files and their package version. 

 

Click Update to browse to the folder where the Data Set files reside. 
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If the selected location does not contain the files, a dialog allows a second try. 
When the Dash Odometer Data Set files are found, SW updates the files in the 
Download Path folder named “datasets”. The next dialog offers to go online and 
update all FMUs. 

 

If No is selected, focus returns to the Dash Odometer Data Set dialog. Site 
Configuration updates and Online sessions verify the Dash Odometer Data Set files 
existence and version and, when necessary, transfer appropriate Dash Odometer 
Data Set files to the FMUs. 
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Dash Odometer Status in the Vehicle Record 

For AIM vehicles, the Dash Odometer latest status and odometer method displays 
on the Vehicle > Odometer tab. 

 

Dash Odometer Reports 

Reports > Vehicle > Vehicle report has been extended to show the history of 
Dash Odometer status when the AIM info box is checked on the report dialog. 

 

Select vehicles individually or check the Select All box to View Report, Print 
Report or Save the report. 
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The report may also be run by Agency, Organization, or Usage using the 
appropriate report tabs. 

Reports > Vehicle > Vehicle Odometer Status Report categorizes vehicles by 
Dash Odometer status. 

This report covers all Dash Odometer statuses: 

• Dash odometer currently being captured 
• Couldn’t find dash odometer using specified data 
• Couldn’t find dash odometer on new model year vehicle 
• No dash odometer data set for vehicle 
• Dash odometer capture not tried yet 
• User Rejected dash odometer 
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Select vehicles individually or check the Select All box to View Report, Print 
Report or Save the report. 

The report may also be run by Agency, Organization, or Usage using the 
appropriate report tabs. 

 
  



FMPlus User Manual 
Document Version: 5.0 

Appendices 
 

12/05/2022 © Syntech Systems, Inc. 2014–2022. 172 

FMU Operations for Dash Odometer 

AIM Record Programming with Supported VINs 

The FMU allows record programming of the AIM unless a Dash Odometer attempt 
is pending. 

 

  

If a Dash Odometer supported VIN fails to meet the programming criteria, the FMU 
notifies the Supervisor that the AIM record cannot be programmed because a 
Dash Odometer capture attempt is pending. After 5 seconds, the FMU prompts 
the Supervisor to turn the vehicle on, wait 30 seconds, turn the vehicle off, and 
then try programming the AIM again. 

Accepting Dash Odometer 

Dash Odometer functionality is found on the Vehicle Record screen. To get to this 
screen, insert the Supervisor Prokee at the FMU, navigate to the AIM Configuration 
Menu, and select PROGRAM. Enter a new Vehicle ID or confirm that the Vehicle ID 
is correct and currently assigned to the AIM. Once an AIM with a Dash Odometer 
supported VIN is programmed successfully, the FMU displays the Vehicle Record 
screen, as seen below:  
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The Vehicle Record screen for a Dash Odometer supported VIN shows the 
standard options: 1=ODOMETER, 2=CHRONOMETER, and D=EXIT. Selecting the 
ODOMETER option shows the Vehicle ID and an Odometer number in miles 
labeled as *DASH* (denoting the odometer is a Dash Odometer) with the options 
to 1=ACCEPT ODOM or 2=REJECT ODOM as seen below: 

 

If ACCEPT ODOM is selected, the vehicle is configured for Dash Odometer and the 
FMU returns to the Vehicle Record screen.  
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Rejecting Dash Odometer 

If the Supervisor selects REJECT ODOM, the Reject Dash Odometer workflow 
commences: 

 

 

In the REJECT ODOM workflow, the Supervisor confirms the intention to revert 
back to Derived Odometer by pressing Y or continues with Dash Odometer by 
pressing N. Next, the Supervisor is asked to start the engine and press Y when it is 
on. Once the FMU is aware that the engine is on, it communicates with the AIM 
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and attempts to switch to a Derived Odometer. If the engine is not running during 
the attempt to switch to Derived Odometer, the Supervisor is prompted to start 
the engine and notify the FMU by pressing Y. If the attempt to switch to Derived 
Odometer is unsuccessful, the Dash Odometer method and value remain 
unchanged on the AIM. Once the attempt to switch to Derived Odometer is 
successful, the Supervisor is notified by the FMU and asked to calibrate the 
odometer. At this point, the Supervisor follows the normal odometer calibration 
process. After the odometer is calibrated, the FMU returns to the Vehicle Record 
screen.  

Manual Option to Retry Dash Odometer 

For AIMs on light duty OBD CAN vehicles currently using Derived Odometer, the 
Supervisor has the option to retry capturing the Dash Odometer. Navigate to the 
Derived Odom screen by selecting ODOMETER on the Vehicle Record screen. The 
FMU shows a Derived Odometer screen as seen below: 

 

On the Derived Odometer screen, the Supervisor can select ACCEPT ODOM to 
accept the current odometer number and return to the Vehicle Record screen. To 
retry Dash Odometer, the Supervisor selects the CFG ODOM option to go to the 
Configure Odom screen as seen below: 
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If the Supervisor selects RETRY DASH ODOM, the manual Retry Dash Odometer 
workflow commences as seen below: 

 

In the manual Retry Dash Odom workflow, the FMU confirms the availability of the 
VIN. If the VIN is not available, the FMU notifies the Supervisor that the dash 
odometer cannot be captured and returns to the Configure Odom screen. Once 
the availability of the VIN is confirmed by the FMU, the Supervisor is prompted to 
start the engine and press Y to confirm when the engine is on. When the 
Supervisor confirms that the engine is running, the FMU communicates with the 
AIM and attempts to capture the Dash Odometer. If the engine is not running 
during the attempt to switch to Dash Odometer, the Supervisor is prompted to 
start the engine and notify the FMU by pressing Y. If the data set for the vehicle is 
not found, the FMU notifies the Supervisor and returns to the Configure Odom 
screen. If the Dash Odometer retry fails, the FMU notifies the Supervisor that the 
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Dash Odometer retry failed, retains the current derived odometer value, and 
returns to the Configure Odom screen. When the Dash Odometer retry is 
successful, the FMU notifies the Supervisor that the Derived Odometer has 
switched to Dash Odometer and that the odometer value should be confirmed. 
After a few seconds, the FMU returns to the Vehicle Record screen. 

Automatic Option to Retry Dash Odometer 

Beginning with FMU FW v4.04, the FMU can automatically retry implementation of 
Dash Odometer. The following conditions must be met: 

• The Dash Odometer Status indicates the FMU previously did a VIN lookup 
for Dash Odometer, but the vehicle is using derived 

• The AIM’s dash odometer package version is lower than the FMU’s package 
version 

• The updated data set must be different from the previous data set that was 
rejected 

NOTE If Dash Odometer was rejected in a previous FMU version, 
automatic retry will not occur. 

If the above conditions are met, the FMU performs a VIN lookup and attempts to 
retrieve a data set. If the data set is found, and is different from the data set 
already tried on the AIM, the FMU sends the new data set files to the AIM. The next 
time the vehicle engine starts the AIM attempts the retry. Results of the retry are 
reported the next time the AIM enumerates. If a data set is not found, the AIM’s 
dash odometer package version is updated, and the odometer will remain derived. 
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Appendix E MultiPoint Download Service 

Overview 
The Multipoint Download Service (MPDS) runs as an application and supports 
multiple services on different machines.  Only one service can be installed per 
Central Controller. With MPDS, a regular user can start manual and automatic 
downloads as part of the FMPlus software application. 

The date and timestamp on servers and clients must be synchronized to prevent 
issues with launching scheduled downloads, Archived Messages, and Polling 
Reports. 

Compatibility 
• SQL Server 2008 R2 and greater, including Windows 10 workstations 

Installation 

MPDS Installation 

After the software and database are installed, FMPlus prompts the user to start the 
Download Service.  Select Yes to install and start the download service.   

If the user selects No, the Download Service Is Not Running dialog shows at 
every start-up, unless the Never ask me again box is checked. 
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At any point in the program, the user can start the FM Download Service by 
selecting Service Configuration from the System menu.  

 

FM Service Controller has multiple Service Controls: 

• Install Service 
• Uninstall Service 
• Run Service 
• Stop Service 

 

NOTE The Options button does not affect the Download Service functions. 

Configuration 
The System > Configuration > DL Service tab provides the following options: 

• Always start FM Download Service when loading FuelMaster –Starts the 
download service automatically on each login to FMPlus.  

• Display autodownload polling report on this computer – Displays the 
Polling Report after each auto-download if the report is set to launch 
automatically in the Polling Report Configuration.   
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To verify the Show on Screen setting, select Polling Report Configuration from the 
System menu.  

 

NOTE If Show on Screen is unchecked, the Polling Report does not 
launch automatically even if Display auto download polling report 
on this computer is checked. Selecting the Show on Screen for 
periodic downloads with a high frequency is not recommended as 
this will consume system resources. 

• Force starting Download Service as normal.exe – Runs the 
FM Download Service as an executable. When checked, the 
‘Start.exe now’ and ‘Stop .exe now’ controls become active. 
This mode should only be used if recommended by Syntech 
Systems, Inc.’s CSC.  

• Data Logger Options – Location a user selects to store the 
Data Logger files after download. 

 

NOTE If the data logger files have not been downloaded in quite a while, the 
card may contain too much data for the system to download. It may be 
necessary to power down the FMU and replace the SD card. 

Operations 

MPDS Operations 

Launch the Online client by clicking the Online icon on the FMPlus toolbar, or 
select Go Online with FMUs from the Operations menu. 

There are four tabs on the FuelMaster® Plus Download Service Client: 

• Archived Messages 
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• Service Requests 
• Auto Download 
• Manual Download 

Manual Download - select different sites by checking the box next to the site or 
select all sites by checking the Select All box. Each manual download request is 
shown on the Service Requests tab. 

 

Review and set the download options. Click Connect.  

Cancel a Manual Download by clicking Disconnect or by clicking Stop on the 
Service Requests tab.    
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Auto Download – Schedule a download for a future date and time by setting the 
Schedule Auto Download options. 

 

Frequency 

• One time – Select start date and time for single download. 

• Daily – Select start time for downloads. 

• Weekly – Select start time and days of the week for downloads to occur.  

• Periodically - Select start time and frequency for recurring downloads.   

NOTE The frequency of periodic download determines when a download occurs 
in relation to the start of the previous download. If the first download is 
scheduled for 1:00 and the frequency is set to 1 hour, the next download 
will be scheduled for 2:00.  If the duration of a single download exceeds 
the download frequency, the next download still begins immediately. 

Click the Schedule button. 

The Auto Download screen stays read-only until the download schedule is 
completed. The Remove Schedule option completely removes the current auto 
download schedule.   

NOTE Daily, Weekly and Periodic Downloads continue until the scheduled 
download is removed. 
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Selecting Disconnect or Remove Schedule may not immediately halt the 
download. The download service needs to perform post processing on each site 
that was being processed and this may take more than a few moments depending 
on the current stage of the download. 

The STOP button is not available for recurring Auto Downloads, i.e., Daily, Weekly, 
and Periodically. It works for Manual and One Time Downloads. 

Review the download in progress with the Status Logger. The Status Logger 
reflects downloads processing for the Manual and Auto Downloads. To open the 
Status Logger, from the View menu, select Show Log DB Data. The Status 
Logger automatically launches when a Manual Download starts. 

 

The top bar of the Status Logger provides a filter for sites to display, as well as, 
the ability to export the content of the logger to a file or clear the screen. 

The Status Log DB Data logs all messages from every download and should not 
be left open unless it is being actively monitored. 
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Service Requests – This option reflects the pending download information. 

 

Archived Messages – the Archived Message tab reflects the status of the Service 
Requests. 

 

Double-clicking on a Download Service Request will launch the Detailed Message 
Status for Message for the selected request.   
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To view the status log files for the selected download, click the View Log Files. 
This opens in a text file that contains the download information for the selected 
site. 

  



FMPlus User Manual 
Document Version: 5.0 

Appendices 
 

12/05/2022 © Syntech Systems, Inc. 2014–2022. 186 

Download Service Status 
To view the Download Service status, click View > List Download Services. 

 

This displays the download services registered with the database and their current 
status. The Master Service is noted in the Comments column.  

The Status column displays if a service is RUNNING or STOPPED.   

 

If the Status is listed as RUNNING, but has not responded for 10 minutes it will be 
highlighted in yellow; the Status will change to INDETERMINATE and turn red. 

• Yellow - means the service was not shut down properly or is not 
communicating with the database. 

• Red – means the service has not been communicating with the database 
for more than 2 days. 

 

 If any of the above occurs, you should: 

• Check to see if the workstation crashed or rebooted. 
• Go to System > Service Configuration and check the status of the 

service.   
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• If the service is RUNNING, check to see if the workstation has network 
access and is communicating with the database. 

• If the service is not RUNNING, restart the Service from the Service 
Configuration dialog. 

• A system reboot might be necessary if the service does not restart. 

The Last Updated column displays the last time the service registered with the 
database.  

The Remove Service button (bottom right of screen) can be used to remove the 
service from the Download Service List, unless the service is running.  

NOTE Remove Service does not uninstall the selected service; it removes 
the listing. If the service restarts or reconnects, it displays in the 
Download Service List. 

Global Purge requires the operator permission Edit Communication Queue. Use 
this function when both the Connect and Disconnect buttons are grayed out on 
the Manual Download tab. 

Troubleshooting 

Connection Lost: 

• If FMPlus losses connection with the database at any point during the 
download, the Download Service Client and Status Logger should be restarted 
after the database connection is restored. If not, the download may appear to 
be in progress or stalled even after it has continued or completed processing. 

• If the services appear to be running slowly or not at all, check the following: 

o Make sure that the SQL Service is running on the server. 

o Make sure the Download Path is accessible or that it is not full. 

• Check FMPlus, under View > List Download Service: 

o If a Download Service Status is RUNNING and the timestamp is within the 
last minute, the service is still active and available for processing. 

o If a Download Service Status is STOPPED, then the service has been 
correctly stopped from its workstation. This occurs if the service was 
stopped through the FMPlus Service Configuration, Windows Services, or if 
the machine has been properly shut down. You can start the Download 
Service from the appropriate workstation. 

o If a Download Service Status is INDETERMINATE, that service’s status is 
unknown. It means the service was not shut down properly or is not 
communicating with the database.  This may be due to: 
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 The workstation unexpectedly crashing 

 A loss of network communication 

• If the service is listed as RUNNING in FMPlus System > Service 
Configuration, check whether the workstation has network access and can 
communicate with the database. If the service is not RUNNING, restart it 
from Service Configuration. 

• A system reboot may be necessary if the service does not restart. 
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Appendix F Managing FMU Settings 

Overview 
FuelMaster Plus® software (FMPlus) now supports managing many of the FMU Settings 
via the Site Configuration uploads and downloads. The feature is accessed on the Site 
dialog. Granting Site permissions to “Manage FMU FW” activates the Advanced 
button. The FMU Settings dialog shows tabs for the Master FMU and each of its 
Satellites. Settings may be reviewed and changed on these tabs. Once the site 
configuration is uploaded to the FMU, these settings are applied each time the FMU 
reboots. 

Compatibility 
Managing FMU Settings via SW requires FMPlus SW v5.21.3.0 and FMU FW 3.95 or 
greater. 

FMPlus SW v5.21.3.0 and FMU FW v3.98 or greater are recommended for automated 
FMPlus updates, which may be used in conjunction with this feature. Contact Syntech 
Systems, Inc.’s CSC for information on automated upgrades. 

 

 

Configuration 

Installation 

The Managing FMU Settings feature installs with FMPlus. Upgrade the SW on all Central 
Controllers. 
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Permissions 

The Advanced button on the Site dialog is grayed out until an operator is granted 
“Manage FMU FW” permission in System > List Maintenance > Operator List > 
[select operator] > Site. This permission is not defaulted for any user. 

NOTE Do not enable the Advanced button until all FMU’s have at least FMU 
FW v3.95. 

Managing FMU Settings Via SW 

Once the permission is applied, on the Site dialog, click the Advanced button to launch 
the FMU Settings dialog. 

Populating FMU Settings 

If FMU Settings is opened before FMUs have been added to the site, a message says 
“No FMUs have been created for this site.” Create the site before returning to FMU 
Settings. 

 

For existing units, a Configuration download is required to retrieve current FMU 
settings. If the feature has not been activated, the first tab says, “You must download 
the FMU Configuration before editing Firmware settings.” 

If the Master FMU has Satellites, there will also be a tab for each satellite. Each tab will 
show this message until the configuration is download for the Master and each 
Satellite. 

NOTE When CSC has done automatic upgrading, the FMU Settings are 
populated and the initial site configuration download is not needed. 
The dialog will open ready to use. 
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All FMU Settings upload with the site configuration which takes effect on the next FMU 
reboot. 
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Editing FMU Settings 

After permissions have been set and FMU Settings have been downloaded, 
click the Advanced button to open the dialog: 

 

Values are changed in a variety of ways: prompts may be edited, dropdowns provide 
ENABLED/DISABLED or other valid selections for many values, and some values are 
not available until the associated feature is enabled. The description box at the bottom 
of the settings list gives additional information about the highlighted setting. 

Some settings, like System Type and Site Signature, are restricted and cannot be 
enabled or changed. Some settings are only enabled for certain system types. 
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When a setting changes, it is bolded to make it easy to find changes during the 
current session. However, if you leave the dialog and don’t send the changes, changes 
for those values are retained but not bolded when the FMU Setting dialog reopens. 

 

 

NOTE Section 54, pump mode and status, have values for each pump but unused 
pump locations are empty (blank). When changing a pump location from a 
valid value to empty, there is no visible indication of the change. 
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If a value has a dropdown, it must be used to set the value. Some drop-downs have 
multiple choices. 
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Other sections, like Tank Monitor, must be enabled before related values can be set. 

 

Sending FMU Settings 
When all settings have been adjusted, select Site > Site List > [select Site] > FMU > 
Online > [select Master and Satellites] > Upload. 

The uploaded settings take effect on FMUs reboots. 
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Appendix G MPDS Online Client Permissions 

Overview 
The Multipoint Download Service (MPDS) Online client supports role-based rights for 
Auto Downloads beginning with FMPlus SW v5.20.3.0. Manual Download functions 
are controlled by the individual operator’s permissions. This expands FMPlus’ 
permission capabilities. For example, it allows giving operators the ability to upload 
lists when they don’t have permissions to download transactions.  

Compatibility 
This feature is supported in FMPlus SW v5.20.3.0 and greater. It was tested with FMU 
FW v4.05 and v4.06 but does not have firmware dependencies.  

Configuration 

Installation 

Install SW v5.20.3.0 or greater on all FMPlus Central Controllers.  

Permissions and Location 

Operators with System > Operator Options > List Maintenance > select Operator > 
Operator & Security > Edit rights can modify permissions for the Auto Download 
role and set permissions for Manual Download by individual operator. 
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With Edit rights, click System > Operator Options > Auto Download Options. 

 

Auto Download Roles 
Launch Auto Download Options to set Auto Download roles for all Operators.  

 

These permissions supersede those set for individual operators and apply to all 
automatic downloads.  
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Every time you leave the Auto Download Options dialog, you are reminded that Auto 
Download needs to be rescheduled for changes to take effect. 

 

When a role is unchecked, even when previously selected, the option on the Online 
client is unchecked and grayed out.  
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These changes take effect on the next online session. 

Operators without Edit rights see the menu option grayed out.  

 
  



FMPlus User Manual 
Document Version: 5.0 

Appendices 
 

12/05/2022 © Syntech Systems, Inc. 2014–2022. 200 

These operators can launch the Online client and see the Auto Download tab. All 
functions are grayed out, but the Site list can be scrolled to see selected Sites. 
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Manual Download Operations 
Operators with Operator > Edit rights can modify the permissions for individual 
operators.  
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When permissions are removed, the permission box is unchecked and grayed out.  

 

Changes take effect on the next online session.  

Prior to SW v5.20.3.0, download options were handled globally based on system 
type. Now, except for modified permissions, each operator’s Online client selections 
are maintained separately and are selected when that operator logs on and accesses 
the Online client. 
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Appendix I Glossary of Terms, Abbreviations 
& Acronyms 

The following are definitions for the terms and acronyms used in FMPlus. This list is 
meant to provide explanation for the most common terms referenced and referred to 
in this manual. 

Administrator: Computer network profile with full permissions/rights; needed to 
install or uninstall the FMPlus software. 

Agency (User Record): Code identifying the agency the user belongs to. Can be up 
to seven alphanumeric characters (lower level than Department). 

Agency (Vehicle Record): Code identifying the agency the vehicle belongs to. Can 
be up to five alphanumeric characters (higher level than Organization). 

Automotive Mode: FMU operational mode that requires an authorized Prokee 
/Smart Card and/or verifiable ID, or AIM for dispensing fuel. 

Automotive Information Module (AIM): The FMPlus 3000 System component 
mounted in a vehicle. It contains vehicle specific information, captures vehicle 
odometer information; integrated dispenser-nozzle mounted RF/ID Tags. Transmits 
this information to an FMU. 

Batch Report: Downloads a report containing credit card end of day settlement 
information. 

Blended Tanks: Virtual tank created in FMPlus database by withdrawing specified 
percentage from two real tanks. 

Central Controller: A Windows-compatible PC set-up for operation of FMPlus. Also 
references the main operator of the software. 

Com Port: Serial port on PC used for connecting peripheral devices such as modems. 

Customer ID: Up to nine alphanumeric characters entered to identify a specific 
customer. 

Deauthorize: Removes vehicle/user/customer authorization to access dispenser with 
Prokee, but maintains vehicle/user/customer record in database (see also Delete). 

Delete (vehicle/user/customer/site):  Deletes vehicle/user/customer/site record 
from database (see also Deauthorize). Not recommended as all record history is lost. 

Delivery: Fuel drop into a designated tank recorded in FMPlus database. 

Department (User Record): Code identifying the department the user belongs to. 
Can be up to six alphanumeric characters (higher level than Agency). 

Discount Card: Credit card that receives a specific discounted price level. 
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Dispenser: Fuel or oil dispensing unit located on a service island and possessing one 
or more dispensing hoses. 

Div/Ratio: Setting (1:1 - 9999:1) programmed into the FMU that determines the 
number of pulses required to count one product unit (i.e., 10:1 pulser produces 10 
pulses for every unit). 

Dynamic IP address: Utilizing the Dynamic Host Configuration Protocol (DHCP) IP 
addresses are assigned by the computer. Dynamic IP addresses can be different each 
time you log onto the network and can even change while logged on. FuelMaster 
recommends utilizing Static IP’s. 

Either Key: Describes an operation requiring use of either a Vehicle Key, user key or 
both keys to access an FMU. Part of the COM system key type. 

Electronic Dispenser: Dispenser controlled by an electronic computer as opposed to 
a mechanical dispenser which has no on-board processor. 

Encoding: Process by which information is transferred to memory in a Prokee/Smart 
Card. 

Encryption: Process whereby data, such as credit card numbers, are translated into a 
secure format. Encryption key is needed to translate data back into the original data 
format. 

Equipment Interface Unit (EIU): FMPlus equipment used with a Master FMU for 
remote access to gates, car washes and doors. 

Export: Procedure for transferring transaction database data to an ASCII file. 
Exported transaction data is removed from transaction database. 

Fixed site: Site with one or more ground-mounted FMUs. 

Fuel Island: Location where FMUs and dispensers are positioned for easy access by a 
vehicle.  See Service Island.  

FuelMaster® Plus (FMPlus): Registered name of the Syntech Systems, Inc., Fuel 
Management System. 

Fuel Management Unit (FMU): System component located on the service or fuel 
island that receives key inputs and activates dispensers. Performs other functions 
dependent upon whether FMU is a Master or a Satellite (See MFMU and SFMU). 

Grade Position: Electronic dispenser setting per pump for grade positions. 

Internal Key Number: Sequential number assigned to each encoded Prokee/Smart 
Card. 

IP Address (Internet Protocol): 32-bit numeric address of a computer on a TCP/IP 
network. Used for routing data packets on a network. 

Inventory: Quantity of product in a storage tank at any given time. 
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Julian Date Rollover Hour: Hour of day (0-24) programmed into the FMU that 
determines when the next accounting day begins. 

Key: Prokee or Smart Card. 

Manual Mode: FMU Operational mode that bypasses FMU control. Used to test the 
operational status of the dispenser independently of the FMU. When the FMU is in 
this mode, no fueling or accounting data is recorded. 

Manual Issue Key: Utility Prokee used to issue products to non-key holders. Key 
contains no restrictions on product types, and has a default transaction limit of 250 
gallons. 

Master Fuel Management Unit (MFMU): System component located on service 
island that receives key inputs, activates dispensers, and communicates with Satellite 
FMUs. Sends Master and Satellite data to the Central Controller. 

Max Prod Allot: Maximum product allowed to be dispensed in a 24-hour period. 
Exceeding this amount can be reported on the Polling Report as an exception. 

Mechanical Dispenser: Dispenser with a mechanical meter reset. 

Message Duration Time Out: Time limit (1-10 seconds) sets length of time messages 
display on the LCD. Does not apply to all messages/displays. 

Mobile Automated Site (M site): Mobile Tanker Trucks equipped with FMU for 
recording transaction data; can download transaction data to a fixed FMU. 

Mobile Non-Automated Site (L site): Mobile Tanker Trucks not equipped with an 
FMU. Transaction data must be manually recorded for later manual entry. 

MPD:  Multi-Product Dispenser, an electronic dispenser capable of dispensing more 
than one product type from a single hose. 

NIC: Network Interface Controller 

No-Pulse Timeout Setting (NPT): (5-255 seconds) programmed into the FMU to 
determine when a transaction terminates if a product is not dispensed after a 
dispenser hose is activated. 

OBD:  On Board Diagnostic computer installed in most automobiles and trucks since 
1996. The AIM is able to interface to the OBD computer via the OBD port on almost 
all vehicle types outfitted with an OBD computer.  Most on-board computers use one 
of several communications protocols which can be read by the AIM. 

Onsite printer: Serial communication printer that is hardwired into the FMU and 
prints FMU transactions and activity.  

Organization (Vehicle Record): Code identifying the organization the vehicle 
belongs to. Can be up to three alphanumeric characters (lower level than Agency).   

PHL: Pump handle setting 
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PIN: Last four digits of Prokee Internal Number 

PIE Address: Fuel pump number designated in the dispenser, FMU and FMPlus 
database for use with electronic dispenser operation. 

PIE Box: Equipment used for data communication between the FMU and electronic 
dispenser. 

PM: Preventive maintenance 

Polling Report: Configurable report that shows status of downloaded transactions. 

Port number: Logical endpoint to a connection in a computer network for 
client/server communication. 

Prepaid Card: Encoded Prokee\Smart Card with a Prepaid amount that is 
recalculated each time it is used at the FMU. 

Price Level: Level of pricing per unit or product. Set by customer, tank or product. 

Prokee: Registered name for access keys to the FMU, which come in six types: AIM 
Programmer, Vehicle, User, Truck, Manual Issue and Supervisor. 

PTO:  Power Take Off - the ability of certain vehicles to power auxiliary devices from 
the vehicle's engine, often used with the vehicle not in motion. 

Pulser: Dispenser device that transmits cost and volume of product dispensed to 
FMU. 

Pump: Dispenser. 

Pump Finish Time Out (PFT): Time period (5-800 seconds) programmed into the 
FMU that determines when a dispenser hose is automatically turned off after product 
is dispensed. Timer begins once FMU stops registering pulses. 

Pump Handle: Switch located on dispenser; also referred to as Pump Reset Switch. 
Setting in FMU configuration, which tells FMU when to look for pulses; if Start or 
Start/End is selected, pump handle switch must be activated before FMU looks for 
pulses. 

Receipt printer: Optional device added to FMU that prints a receipt after dispensing 
transactions. 

Re-Encode: Procedure for encoding a re-issued key. 

Re-Issue: Procedure for re-authorizing a key record that was previously de-
authorized. Permits a key to be encoded with the same key record information. 

RF:  Radio Frequency - the ability to communicate without wires using radio waves 
of various frequencies. 

Restore: Procedure for returning archived data to a database. 
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Satellite Fuel Management Unit (SFMU): System component located on service 
island that receives key inputs, activates dispensers, and relays transaction data 
through the MFMU(s). 

Server computer: A machine that runs a service available on the network. 

Service Island: Location where FMUs and dispensers are positioned for easy access 
by a vehicle.  

Servicing Site: Term to describe the location of the service island(s) and station 
house. 

Site Signature: Computer generated security number that is unique to an 
organization’s FMU, database and all associated Prokee/Smart Cards and/or AIMs. 

Smart Card: Access card for fueling at an FMU which uses a smart chip programmed 
with customer specific information. May be used instead of Prokees. 

Static IP Address: Fixed IP addresses assigned by the network administrator. 

STS: Abbreviation for Syntech Systems, Inc. 

Supervisor Key: Utility Prokee used to configure FMUs, perform servicing site 
troubleshooting and system diagnostic tests, to issue products to non-key holders, to 
update product quantity in FMU memory, and to extract on-site reports. 

Syntech: Syntech Systems, Inc. 

System Key Type: FMPlus and FMU mode of operation. Each type explained in detail 
in Chapter 1. 

Tanker Truck Key: Utility Prokee used by a mobile Tanker Truck driver to fill a 
Tanker Truck from an FMU-controlled dispenser. 

Tanker Truck: Truck with fuel storage tank for taking fuel to remote fueling locations; 
may be automated with attached FMU, or non-automated which requires manual 
entry of each transaction. 

TMU: Tank Monitor Unit. 

Transaction: Action that updates FMU memory either as the result of product 
dispensing or through manual entry of information. 

Transaction Limit: Amount of fuel that is allowable per transaction. Cannot exceed 
this limit. 

Transaction Code (TC): 2-character code used to distinguish types of transactions. 

Two Key: Describes operation-requiring use of both a Vehicle Key and user key to 
access an FMU. 

Unit of Issue (UI): Unit of measure for products; designated by two letters (i.e., GL 
for gallons, QT for quarts, etc.). 



FMPlus User Manual 
Document Version: 5.0 

Appendices 
 

12/05/2022 © Syntech Systems, Inc. 2014–2022. 208 

Update (Prokee): Requires key to perform update. Changes information contained 
on the key; not necessary to upload information to FMU after update. 

USB Port: Universal Serial Bus port on the computer. 

User ID: Up to 9 alphanumeric characters entered to identify a specific user.  

User Key: Prokee assigned to a User. 

Utility Key: A Supervisor, a Manual Issue, or a Tanker Truck key. 

Valid Key Time Out: Time limit (5-255 seconds). Time allowed before terminating a 
transaction if no dispenser hose is selected after Prokee insertion. 

Vehicle Key: Prokee assigned to a vehicle and used to fuel through an FMU. 

Vehicle ID: Up to 8 alphanumeric characters entered to identify a specific vehicle.  

Zero Quantity Shutdown No: Setting (1-50) determines the number of zero-quantity 
transactions that may be recorded before shutting down a dispenser. Prevents 
continued use of system if FMU is not recording transaction information (i.e., 
defective pulser or other issues). 
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